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1 Einleitung 
RegioGraph unterstützt als geographisches Informationssystem (GIS) die Darstellung und Analyse von 
raumbezogenen Daten. Das von der GfK GeoMarketing GmbH, einer in Bruchsal bei Karlsruhe ansäs-
sigen Tochter der GfK (Gesellschaft für Konsumforschung) entwickelte Programm kümmert sich als 
Geomarketing-Software speziell um Kunden-, Markt- und Unternehmensdaten. Das gilt speziell für die 
an der Universität Trier verfügbare Ausbaustufe RegioGraph Planung. RegioGraph eignet sich aber 
auch für nichtkommerzielle Projekte. Ein einfaches Anwendungsbeispiel ist die folgende Deutschlandkar-
te mit farblich sowie numerisch dargestellten Daten über die Verkehrssicherheit in den deutschen Bun-
desländern: 

 

Beim Einsatz von RegioGraph verwendet man in der Regel eine der zahlreichen mitgelieferten Karten 
zur Visualisierung von Daten, die meist aus anderen Quellen (z.B. aus eigener Forschungsarbeit) stam-
men. Über das Basispaket mit Karten zu Deutschland, Österreich und Schweiz hinaus bietet der Herstel-
ler Karten zu allen Regionen der Erde und zu vielen thematischen Schwerpunkten an. An der Universität 
Trier sind detaillierte Karten zu den meisten Ländern Europas verfügbar. 

RegioGraph kann Karten in den Fremdformaten ESRI Shape und MapInfo Interchange Format impor-
tieren. Außerdem enthält RegioGraph Planung einen Editor zum Erstellen (Digitalisieren) eigener Kar-
ten. 

In der folgenden Tabelle sind exemplarisch die im Lieferumfang von RegioGraph 11 zu Deutschland ver-
fügbaren Karten aufgelistet, wobei zwischen Gebiets-, Linien-, Punkte- und Flächenschichten sowie Hin-
tergrundkarten unterschieden wird (siehe unten):  

http://www.gfk-geomarketing.de/�
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Gebietsschichten 

Administrative Gebiete 
Bundesländer 2009 
Bundestagswahlkreise 2009 
Gemeinden 2009 
Regierungsbezirke 2009 
Stadt- und Landkreise 2009 

Sonderkarten 
IHK-Bezirke 2009 
Kassenärztliche Vereinigungsgebiete 2009 
Nielsen-Gebiete 2009 
Nielsen Standard-Regionen 2009 

Postleitzahlgebiete 
Postleitbereiche 2009 
Postleitregionen 2-stellig 2009 
Postleitzahlen 3-stellig 2009 
Postleitzahlen 4-stellig 2009 
Postleitzahlen 5-stellig 2009 
Postleitzonen 1-stellig 2009 

Topographie 
Höhenschichten 
 

Linienschichten 

Autobahnen 2009 
Hauptstraßen 2009 
Nebenstraßen 2009 
Verbindungsstraßen 2009 

Fähren/Tunnels 2009 
Eisenbahnnetz 2009 

Punkteschichten 

Städte < 5.000 Einwohner 
Städte    5.000 – 10.000 Einwohner 
Städte  10.000 – 20.000 Einwohner 
Städte  20.000 – 50.000 Einwohner 

Städte 50.000 – 100.000 Einwohner 
Städte >100.000 Einwohner 
Flughäfen 

Flächenschichten 

Gewässer 
Siedlungsflächen 
Waldflächen 
Wattflächen 

Industrieflächen 
Flughafengelände 
Flughafen-Rollbahnen 
 

Hintergrundkarten 

Verkehr 
Städte 
Gewässer 

Landschaft 
POI (Point Of Interest) 
Europa Hintergrund 

Eine RegioGraph-Kartenschicht muss nicht unverändert bleiben, sondern kann z.B. durch Ausblenden 
irrelevanter Gebiete oder durch Zusammenfassen von Gebieten an spezielle Aufgabenstellungen ange-
passt werden. 

Zu jeder RegioGraph-Kartenschicht gehört eine Tabelle, deren Zeilen mit den geographischen Objekten 
der Kartenschicht (z.B. Gebieten) verknüpft sind. Die in den Spalten der Tabelle enthaltenen Merkmale 
der geographischen Objekte können auf vielfältige Weise in der Karte visualisiert werden, z.B. die relati-
ve Häufigkeit der Unfallopfer in den deutschen Bundesländern durch verschiedene Farben in der zugehö-
rigen Gebietsschicht (siehe oben). In diesem Manuskript werden zahlreiche weitere Darstellungsoptionen 
beschrieben. Die zu visualisierenden Daten können aus verschiedenen Quellen in die Tabellen zu den mit 
RegioGraph erworbenen, importierten oder selbst erstellten Kartenschichten übernommen werden. 

RegioGraph enthält neben den Karten auch umfangreiche Kaufkraftdaten der GfK (Gesellschaft für 
Konsumforschung) zu 17 westeuropäischen Ländern (inkl. Deutschland, Österreich, Schweiz) und zu 
verschiedenen Gebietsaufteilungen auf Europaebene (Staaten, Regionen, NUTS, zweistellige Postleitzah-
len). 
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2 Überblick 

2.1 Geographische Objekte, Schichten und Karten 

Beim Arbeiten mit RegioGraph sind folgende Typen geographischer Objekte zu unterscheiden: 

 Gebiete  
Eine Gesamtfläche wird durch Grenzlinien in benachbarte Gebiete zerlegt (siehe Einleitungsbeispiel 
mit den deutschen Bundesländern). 

 Flächen  
Im Unterschied zu Gebieten verfügen Flächen im Allgemeinen nicht über gemeinsame Grenzen (z.B. 
Seen, Waldgebiete etc.). 

 Punkte  
Mit Punkten werden auf einer Karte z.B. Orte markiert. 

 Linien  
Mit Linien werden z.B. Straßen und Eisenbahnstrecken dargestellt. 

In RegioGraph kann jede Karte aus mehreren Schichten bestehen, die jeweils geographische Objekte 
eines Typs enthalten. RegioGraph kennt also Gebiets-, Flächen-, Punkt- und Linienschichten. 

Beim Arbeiten mit RegioGraph können Sie .... 

 die mitgelieferten Schichten unverändert verwenden 
 Schichten modifizieren (z.B. Punkte ergänzen) 
 Schichten importieren (z.B. im Format ESRI Shape) 
 eigene Schichten erstellen 

Neben den geographischen Schichten kann man auch noch Schichten mit beliebigen Objekten  (z.B. 
Pfeilen, Beschriftungen) anlegen, die einen Bezug zu geographischen Objekten haben und daher z.B. bei 
einer Maßstabsveränderung analog transformiert werden sollen. 

Seit der Version 11 enthält RegioGraph so genannte Hintergrundkarten, die analog zu Kartenschichten 
behandelt (z.B. in eine Karte integriert) werden können, aber doch einige Besonderheiten aufweisen, z.B.: 

 Sie ermöglichen das Lokalisieren von Punkten und Strecken aufgrund von Postadressen. 
 Sie eignen sich als illustrativer Hintergrund für thematische Karten. 
 Sie lassen sich im Unterschied zu anderen Schichten nicht modifizieren. 
 

2.2 Tabellen mit Daten zu den Objekten einer Kartenschicht 

Eine wesentliche Leistung von RegioGraph besteht in der Möglichkeit, die geographischen Objekte einer 
Kartenschicht mit Daten zu verknüpfen, wobei die Daten in der Karte auf unterschiedliche Weise ange-
zeigt werden können (z.B. durch Farben oder Kreisdiagramme). Dazu besitzt jedes geographische Objekt 
einer Kartenschicht eine eindeutige Kennung. Zu jeder Kartenschicht gehört eine Tabelle, die für jedes 
geographische Objekt eine Zeile enthält. In der ersten Tabellenspalte stehen die Objektkennungen, weite-
re Spalten können beliebig viele Merkmale zur Beschreibung der Objekte enthalten. In der Terminologie 
der angewandten Statistik entspricht jedes geographische Objekt einem Fall und jede Tabellenspalte einer 
Variablen. 

Hier ist die Tabelle zur Gebietsschicht der deutschen Bundesländer nach Aufnahme des Merkmals EIN-
WOHNER zu sehen: 



 

 9 

Thematische Kartographie mit RegioGraph 11 
 

 
Wir werden diese Tabelle später per Datenimport noch erheblich erweitern und dabei u.a. die mit Regio-
Graph gelieferten Kaufkraftdaten und öffentlich zugängliche Informationen des statistischen Bundesamts 
verwenden. 
 

2.3 Projekte und Arbeitsblätter 

In einem RegioGraph-Projekt legt man jeweils ein Arbeitsblatt an, um eine Präsentation aufzubauen. 
Auf einem Arbeitsblatt wird man in der Regel eine Landkarte unterbringen, aber es dürfen auch mehrere 
sein (bei entsprechend großem Seitenformat). Wie eben berichtet, darf jede Landkarte aus mehreren 
Schichten bestehen, die jeweils geographische Objekte eines bestimmten Typs enthalten (z.B. Gebiete, 
Linien oder Punkte). Zu jeder Schicht gehört eine Tabelle mit Informationen über ihre geographischen 
Objekte. 

Neben den Landkarten können auf einem Arbeitsblatt auch Texte (z.B. Überschriften, Fußnoten), Zeich-
nungselemente (z.B. Linien, Rechtecke, Ellipsen) und Multimedia-Objekte (z.B. Bilder, Videos) unterge-
bracht werden. 
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3 Einstieg in das Arbeiten mit RegioGraph 

3.1 RegioGraph starten 

Auf den vom ZIMK betreuten Pool-PCs an der Universität Trier wird RegioGraph Planung 11 über den 
folgenden Menübefehl gestartet: 

Start > Alle Programme > Wissenschaftliche Programme > 

RegioGraph > RegioGraph Planung 11.0 

3.2 Neues Projekt erstellen 

Wenn Sie im Startdialog 

 
die Option Neues, leeres Projekt erstellen wählen, entsteht im voreingestellten Projektbasisver-
zeichnis eine neue Projektdatei mit einem automatisch gebildeten Namen (z.B. Projekt.gfk), den Sie 
selbstverständlich per Windows-Explorer später ändern können. 

Wenn Sie den Startdialog per Schließkreuz  verlassen und anschließend den Menübefehl 

Datei > Neues Projekt 

verwenden, dürfen Sie das Verzeichnis und den Namen für die neue Projektdatei festlegen, z.B.: 
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Geben Sie den Namen der Projektdatei ohne Namenserweiterung an, womit die Voreinstellung .gfk über-
nommen wird. Beim RegioGraph-Einsatz im Campusnetz der Universität Trier wird das folgende Pro-
jektbasisverzeichnis empfohlen und beim ersten RegioGraph-Start automatisch angelegt: 

U:\Eigene Dateien\Regio\Projekte 

Bei den meisten RegioGraph-Projekten finden alle Bestandteile (Schichten, Tabellen etc.) in einer Datei 
Platz, und diese Projektdatei ist im Basisordner für Projekte gut aufgehoben. Bei einem umfangreichen 
Projekt mit vielen Arbeitsblättern und Kartenschichten kann die Projektdatei einen erheblichen Umfang 
erreichen (z.B. 1 GB und mehr), so dass entsprechend viel freier Speicherplatz benötigt wird. Gehören zu 
einem Projekt auch Hilfsdateien (z.B. mit zu importierenden Kartenschichten oder Daten), dann sollte 
man dem Projekt der Übersichtlichkeit halber einen Unterordner spendieren (siehe Beispiel im obigen 
Bildschirmphoto). 

Nach dem Quittieren der Dialogbox Neues Projekt über den Schalter Öffnen finden Sie in der Pro-
jektverwaltung (hier der Übersichtlichkeit halber von der Standardposition am linken Rand des Regio-
Graph-Fensters „losgerissen“) zwei Ordner zur Aufnahme von Arbeitsblättern und Layern (Schich-
ten): 

 
RegioGraph hat spontan ein erstes Arbeitsblatt (mit dem änderbaren Namen Arbeitsblatt 1) angelegt 
und im Dokumentenbereich geöffnet: 

 

Ein Projekt kann beliebig viele Arbeitsblätter enthalten. Im Ordner Layer werden die (eventuell in meh-
reren Karten) verwendeten Schichten abgelegt (Gebietslayer, Punktelayer, Linienlayer, Flächenlayer, 
Objektelayer). Im Projekt verwendete Hintergrundkarten erscheinen nicht in der Projektverwaltung. 
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3.3 Schichtvorlagen in ein Projekt übernehmen 

In der Kartenbibliothek (Standardposition: am linken Rand des RegioGraph-Fensters, unter der Projekt-
verwaltung) werden die aktuell verfügbaren Kartenvorlagen und die Hintergrundkarten angezeigt. Beim 
RegioGraph-Einsatz im Campusnetz der Universität Trier finden Sie hier per Voreinstellung Kartenvor-
lagen und Hintergrundkarten zu Deutschland, Österreich und der Schweiz: 

 
Um eine Schichtvorlage in das aktuelle Projekt zu übernehmen, wird sie per Maus von der Kartenbiblio-
thek auf die Projektverwaltung gezogen, woraufhin sie im dortigen Layer-Ordner landet, z.B.: 

 

Wählen Sie bitte für die anschließenden Übungen aus dem Kartenbibliotheksordner 

Karten > Deutschland 2009 > Administrative Gebiete 

die Gebietsschicht 

Bundesländer Deutschland 2009 

Ist im Projekt bereits ein Arbeitsblatt vorhanden und geöffnet (wie in unserer aktuellen Situation), kann 
man eine Schicht aus der Kartenbibliothek auch per Maus direkt auf das Arbeitsblatt befördern, wobei die 
Schicht automatisch in die Projektverwaltung aufgenommen wird. Ist das Arbeitblatt noch leer, entsteht 
dort eine Landkartenbox mit der abgelegten Schicht. In eine bereits vorhandene Landkarte kann man auf 
direktem Weg eine zusätzliche Schicht aus der Kartenbibliothek einfügen. 

Um an Karten zu anderen Ländern und Kontinenten heranzukommen, müssen Sie das Kartenbiblio-
theks-Verzeichnis ändern, was am schnellsten über das Kontextmenü zur Kartenbibliothek gelingt: 
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Alternativ können Sie über den Menübefehl 

Extras > Optionen > Verzeichnisse 

den Optionen-Dialog öffnen 

 
und hier auf den Erweiterungsschalter  zum Kartenbibliotheks-Verzeichnis klicken. Unabhängig 
vom gewählten Weg präsentiert schließlich der folgende Dialog die verfügbaren Vorlagen-Unterordner, 
die sich hinsichtlich Geographie und Erscheinungsjahr unterscheiden: 

 
Wenn Sie z.B. den Pfad 

W:\Vorlagen\Edition 2009\Europa 2008\Europäische Länder 2008\Luxemburg 2008 

wählen, stehen anschließend in der Kartenbibliothek aktuelle Karten aus unserem Nachbarland bereit: 
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Im Ordner W:\Vorlagen\Edition 2001 finden Sie (weniger detaillierte und eventuell veraltete) Karten 
zu Ländern außerhalb Europas: 

 
 

3.4 Arbeitsblatt erstellen 

Auf einem Arbeitsblatt wird jeweils eine eigenständige Präsentation erstellt, die Landkarten und Layout-
Objekte (z.B. Beschriftungen, Grafiken) enthalten darf. Wie Sie bereits wissen, legt RegioGraph zu ei-
nem neuen Projekt spontan ein erstes Arbeitsblatt an: 
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Mit dem Menübefehl 

Datei > Neues Arbeitsblatt 

oder mit dem Symbolschalter  fordert man bei Bedarf ein weiteres Arbeitsblatt an. Es erscheint in der 
Projektverwaltung und ist im Dokumentenbereich von RegioGraph geöffnet. 

Via Kontextmenü oder nach einem Mausklick auf seinen bereits markierten Namen lässt sich ein Ar-
beitsblatt individuell benennen. 
 

3.5 Landkarte erstellen 

Ziehen Sie nun die Gebietsschicht Bundesländer Deutschland 2009 aus dem Layer-Ordner der 
Projektverwaltung auf das Arbeitsblatt, wobei eine neue Landkarte entsteht: 

 

Im Fenster mit dem Karteninhalt (per Voreinstellung oben links auf dem RegioGraph-Arbeitsplatz zu 
finden) werden alle Schichten der aktiven Karte angezeigt und verwaltet. Bei einer frisch erstellten Karte 
ist hier genau eine Schicht zu finden, wobei man in der Regel mit einer Gebietsschicht startet. Weitere 
Layer zieht man bei Bedarf aus der Projektverwaltung oder der Kartenbibliothek auf die Karte, wobei aus 
der Bibliothek direkt in eine Karte übernommene Vorlagen automatisch auch in die Projektverwaltung 
aufgenommen werden. 
 

3.6 Projekt speichern, reorganisieren 

Das Speichern des aktuellen Projekts veranlasst man per Mausklick auf das Symbol  oder mit dem Me-
nübefehl 

Datei > Alles speichern 
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Alle Arbeitsblätter und Schichten eines Projekts werden in der Projektdatei gespeichert, die dementspre-
chend groß werden kann. Durch das Löschen von Arbeitsblättern oder Schichten kommt es zu einer 
Fragmentierung der Projektdatei mit unerwünschten Folgen: 

 Reduzierte Verarbeitungsgeschwindigkeit 
 Verschwendung von Speicherplatz 

Mit dem folgenden Menübefehl kann man die Projektdatei defragmentieren: 

Datei > Reorganisieren 

Dabei darf kein Arbeitsblatt geöffnet sein. 
 

3.7 Weitere Optionen der Projektverwaltung 

Mit der Projektverwaltung kann man über das Kontextmenü des betroffenen Objekts u.a. … 

 ein Arbeitsblatt oder eine Schicht löschen 

 ein Arbeitsblatt duplizieren 

 ein Arbeitsblatt in eine Datei (mit der Namenserweiterung .map) exportieren oder von dort importie-
ren (via Kontextmenü zum Ordner Arbeitsblätter) 

 ein Arbeitsblatt als Arbeitsblattvorlage (siehe unten) in einer Datei mit der Namenserweiterung .fra 
speichern oder eine Arbeitsblattvorlage öffnen (via Kontextmenü zum Ordner Arbeitsblätter) 

 eine Schicht in die Windows-Zwischenablage kopieren oder von dort einfügen (via Kontextmenü zum 
Ordner Layer) 

 eine modifizierte Schicht (siehe unten) als Datei (mit der Namenserweiterung .lay) in der Kartenbib-
liothek speichern 

 zur Förderung der Übersichtlichkeit bei komplexen Projekten Unterordner zum Arbeitsblatt- oder 
Layer-Ordner anlegen 

Wird aus einem Arbeitsblatt eine Arbeitsblattvorlage erstellt, landen alle Grafikelemente und -attribute 
(z.B. Beschriftungen, ein flächendeckendes Rechteck zur Hintergrundeinfärbung, eine illustrierende Ab-
bildung) in einer Datei mit der Namenserweiterung .fra, wobei von Landkarten nur die leeren Boxen ein-
bezogen werden. Beim Öffnen einer Arbeitsblattvorlage entsteht ein neues Arbeitsblatt, dessen Landkar-
tenboxen ggf. leer sind. 
 

3.8 Landkarten- und Layout-Modus 

RegioGraph kennt zwei Bearbeitungsmodi: 

 Landkarten-Modus 
Er ist für die Landkarten- bzw. Schichtbearbeitung gedacht und bietet entsprechende Werkzeuge (z.B. 
zur Wahl eines Maßstabs oder zum Einfärben von Gebieten aufgrund eines Merkmals). 

 Layout-Modus 
Im Layout-Modus werden die Karten auf dem aktuellen Arbeitsblatt wie Grafiken behandelt. Sie kön-
nen z.B. vergrößert, verkleinert oder verschoben werden. Außerdem können sonstige Objekte auf dem 
Arbeitsblatt erstellt und bearbeitet werden (z.B. Beschriftungen). Ändert sich die Größe der Landkar-
tenbox, muss die Karte in der Regel neu eingepasst werden. Daher ist es sinnvoll, vor aufwendigen 
Arbeiten im Landkarten-Modus zunächst im Layout-Modus die endgültige Größe der Landkartenbox 
festzulegen. 

Um für eine Karte den Landkarten-Modus zu aktivieren, setzt man einen Doppelklick darauf. Anschlie-
ßend erhält die Karte einen schraffierten Markierungsrahmen in einer vom Windows-Farbschema abhän-
gigen Farbe (siehe Abbildung in Abschnitt 3.5). Außerdem werden die Schichten der zu bearbeitenden 
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Karte im Fenster Karteninhalt aufgelistet. Schließlich erkennt man den Landkarten-Modus daran, dass 
der Symbolschalter  für den Wechsel in den Layout-Modus verfügbar ist. Man kann die Bearbeitung 
einer Karte auch per Mausklick auf eine Arbeitsblattposition außerhalb der Landkartenbox beenden und 
dabei den Layout-Modus aktivieren. 
 

3.9 Arbeitsplatz umgestalten 

Sie können den im RegioGraph-Anwendungsfenster verfügbaren Platz nach eigenen Wünschen aufteilen. 
Die per Voreinstellung am linken Rand angedockten Subfenster (Karteninhalt, Projektverwaltung und 
Kartenbibliothek) lassen sich u.a. ... 

 per Maus an der Titelzeile packen und verschieben 

 vom frei beweglichen Zustand aus an jeder beliebigen Seite des RegioGraph-Fensters andocken 

 per Doppelklick auf die Titelzeile in den vorherigen Zustand (angedockt oder beweglich) zurückver-
setzen 

 über das Ansicht-Menü aus- oder einschalten 

 im angedockten Zustand über den Symbolschalter  zum automatischen Verschwinden in einen Be-
reitschaftszustand am Rand des RegioGraph-Fensters zwingen bzw. über den Schalter  zur norma-
len Permanenz überreden 

Der folgende Menübefehl stellt den Normalzustand wieder her: 

Ansicht > Standard wiederherstellen 

Arbeitsblätter und Tabellen (siehe unten) belegen beim Öffnen den gesamten Dokumentenbereich des 
RegioGraph-Fensters, können aber über das Fenster-Menü bzw. die Schaltfläche  auch in Subfenster 
gesteckt werden, wie es im folgenden Beispiel für ein Arbeitsblattfenster und ein Tabellenfenster zu 
sehen ist: 
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Über die Registerleiste unter dem Dokumentenbereich kann man ein geöffnetes Dokument ansteuern, 
speichern oder schließen. 

Über den Menübefehl 

Ansicht > Zoom Arbeitsblatt 

bzw. über das Symbolleisten-Steuerelement  lässt sich ein Vergrößerungs- oder Verkleine-
rungsfaktor für das aktive Arbeitsblatt einstellen. 

Auch die normalerweise unter dem Hauptmenü stationierten Symbolleisten (Standard, Kartenfunkti-
onen, Formatieren usw.) kann man verschieben, losreißen und (z.B. per Doppelklick auf die Titelzei-
le) erneut andocken. 

Nach einem rechten Mausklick auf eine freie Stelle in der Symbolleistenzone des Anwendungsfensters 
erscheint ein Menü, mit dem sich die RegioGraph-Symbolleisten ein- bzw. ausschalten lassen: 

 
Außerdem ist hier eine Dialogbox zum Konfigurieren der Symbolleisten ansprechbar, die z.B. ein indi-
viduelles Bestücken mit Symbolschaltern erlaubt: 

 

Außerdem lassen sich in diesem Dialog einzelne Symbolleisten auf den Originalzustand zurücksetzen.1 

Wer seine bevorzugte Konfiguration gefunden hat, kann diese mit dem Item Symbolleisten Sperren 
aus dem Kontextmenü der Symbolleistenzone konservieren. 
 

                                                 
1 Ein globales Zurücksetzen über den Menübefehl Ansicht > Standard wiederherstellen ist nicht möglich. 
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4 Gestaltungsmöglichkeiten im Layout-Modus 
In diesem Abschnitt geht es um die graphische Gestaltung eines Arbeitsblatts, das neben Landkarten noch 
diverse andere Objekte aufnehmen kann. RegioGraph besitzt neben seinen Kernkompetenzen als Geo-
marketing-Software auch die grundlegende Funktionalität eines Vektorgrafikprogramms. 
 

4.1 Seitenformat ändern 

Nach dem Menübefehl 

Datei > Seite einrichten 

oder nach einem Mausklick auf den per Symbolleisten-Konfiguration (siehe Abschnitt 3.9) nachrüstbaren 
Schalter  kann das Seitenformat des geöffneten Arbeitsblatts in der folgenden Dialogbox geändert wer-
den: 

 

Die letzte Wahl dient als Voreinstellung für neue Arbeitsblätter. 

Mit dem Schalter  kann man für das geöffnete Arbeitsblatt zwischen Hoch- und Querformat wechseln. 
 

4.2 Bearbeitungen zurücknehmen bzw. wiederherstellen 

Im Layout-Modus können die meisten Modifikationen mit dem Menübefehl 

Bearbeiten > Rückgängig 

oder mit dem Schalter  oder mit der Tastenkombination Strg+Z rückgängig gemacht bzw. mit dem 
Menübefehl 

Bearbeiten > Wiederherstellen 

oder mit dem Schalter  oder mit der Tastenkombination Strg+Y wiederhergestellt werden (auch mehr-
stufig). 
 

4.3 Neue Grafikobjekte einfügen 

Über das Einfügen-Menü kann man diverse Grafikobjekte auf ein Arbeitsplatt setzen: 

  Linie 
Jeder Mausklick ergibt einen Verbindungspunkt des Linienzugs. Die Fertigstellung wird per Dop-
pelklick angefordert. Um eine Freihandlinie oder ein Freihandsegment in einem Linienzug zu 
zeichnen, klickt man auf den Startpunkt, zieht die Maus bei gedrückter Maustaste bis zum Ziel-
punkt und lässt die Maustaste dann wieder los. Um die Linie am Zielpunkt zu beenden setzt man 
einen Doppelklick. 
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  Polygon 
Jeder Mausklick ergibt einen Verbindungspunkt des Polygons. Die Fertigstellung (mit dem auto-
matischen Schließen der Figur) erreicht man … 

 per Doppelklick auf den letzten Etappenpunkt 
 oder durch einen Klick auf den Startpunkt, den ein roter Kreis markiert, wenn er sich unter 

dem Mauszeiger befindet. 
Um ein Freihandpolygon oder ein Freihandsegment in einem Polygon zu zeichnen, klickt man auf 
den Startpunkt, zieht die Maus bei gedrückter Maustaste bis zum Zielpunkt und lässt die Maustas-
te dann wieder los. 

  Ellipse 
Um eine Ellipse zu zeichnen, setzt man einen Mausklick auf die linke obere Ecke des umschrei-

benden Rechtecks, zieht die Figur bei gedrückter Maustaste auf lässt die Maus dann wieder los. 

Größe und Seitenverhältnis einer fertigen Ellipse lassen sich über acht Ziehpunkte ändern: 

 
Wenn Sie die Umschalttaste   drücken, während Sie per Mausklick die linke obere Ecke des 
umschreibenden Rechtecks festlegen, resultiert beim anschließenden Ziehen der Maus ein Kreis. 

  Rechteck 
Beim Zeichnen eines Rechtecks ist analog zum Erstellen einer Ellipse vorzugehen (siehe oben). 

Mit Hilfe der Umschalttaste   erhält man ein Quadrat (siehe Beschreibung zur Ellipse). 

  Gerundetes Rechteck 
Beim Zeichnen eines Rechtecks mit gerundeten Ecken ist analog zum Erstellen einer Ellipse vor-

zugehen (siehe oben). Mit Hilfe der Umschalttaste   erhält man ein Quadrat mit gerundeten 

Ecken (siehe Beschreibung zur Ellipse). Über einen speziellen Ziehpunkt lässt sich der Run-

dungsgrad einstellen: 
 

 

  Textfeld 
Von dieser Möglichkeit wollen wir im Rahmen des Übungsprojekts Gebrauch machen. Platzieren 
Sie eine Textbox in Titelposition (am oberen Rand des Arbeitsblatts) und tragen Sie als Text ein: 
Verkehrssicherheit 2006. Um eine passende Schriftart und den überflüssigen Rahmen der Textbox 
kümmern wir uns später. Wenn Sie einen vorhandenen Text ändern wollen, müssen Sie einen 
Doppelklick darauf setzen. 

  Grafik aus Datei 
Wenn Sie diese Option wählen, müssen Sie zunächst per Maus einen Rahmen aufziehen. Dann 
können Sie eine Grafikdatei öffnen, wobei folgende Formate unterstützt werden: BMP, JPEG, 
EMF, WMF, GIF, TIFF, PNG. 

  Grafik aus der Palette 
Wenn Sie diese Option wählen, müssen Sie zunächst per einen Rahmen aufziehen. Dann können 
Sie im folgenden Fenster ein Symbol aussuchen und mit OK in den Rahmen befördern: 
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Per Kontextmenü zum Symbol-Fenster lassen sich Symbole hinzufügen, löschen und ein-
stellen. Unterstützte Dateiformate beim Hinzufügen: BMP, JPEG; EMF, WMF, GIF, TIFF, 
PNG. 

Im Einstellen-Dialog lassen sich folgende Eigenschaften eines Symbols ändern: 

 die variable Farbe (relevant für die Verwendung eines Symbols zur Daten-Visualisierung) 

 
Im Beispiel kann man bei der variablen Farbe zwischen Blau und Weiß wählen, indem man 
auf eine entsprechend gefärbte Zone der Symbolanzeige klickt. 

 die transparente Farbe (nur relevant bei Bitmap-Formaten) 

 
Die Pixel mit der gewählten Farbe werden nicht angezeigt, wenn das Symbol als Layout- 
oder Kartenbestandteil (siehe unten) Verwendung findet, z.B.: 
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 Hot Spot für die Lokalisierung des Symbols über einem darzustellenden Zielpunkt 

 
Von der Hersteller-Webseite 

http://www.regiograph.de/anwenderunterstuetzung/downloads.html 

können zusätzliche Symbole zur Verwendung mit RegioGraph herunter geladen werden. Man er-
hält (verpackt in ein ZIP-Archiv) eine Datei mit der Namenserweiterung .pal mit einer im Ver-
gleich zur RegioGraph-Originalausstattung erweiterten Liste von Symbolen. Diese Datei kann 
über den Menübefehl 

Format > Palette 

mit Gültigkeit für die aktuelle RegioGraph-Sitzung an Stelle der vorherigen Palette geladen wer-
den. Mit demselben Menü kann man die aktuelle Palette speichern oder die Standardpalette reak-
tivieren. Soll eine individualisierte Palette über die Sitzung hinaus erhalten bleiben, muss sie vor 
dem Verlassen von RegioGraph bzw. vor dem Laden einer anderen Palette gespeichert werden. 
Das Ändern der Standardpalette erfordert Administratorrechte, ist also z.B. auf den ZIMK - Pool-
PCs für Normbenutzer nicht möglich. 
Um ein Symbol aus einer Palette zu entnehmen und in einem anderen Kontext zu verwenden (z.B. 
in eine andere Palette aufzunehmen), kann man so vorgehen: 

 Symbol im Layout-Modus auf ein Arbeitsblatt einfügen 
 Eingefügtes Symbol markieren und in die Windows-Zwischenablage befördern 
 Symbol in einem geeigneten Programm (z.B. Microsoft Powerpoint) aus der Zwischenabla-

ge entnehmen und in einer Datei speichern (in Powerpoint über das Kontextmenü-Item Als 
Grafik speichern) 

  Ole-Objekt 
Nach dem Aufziehen eines Rahmens wählt man den Objekttyp: 

 

http://www.regiograph.de/anwenderunterstuetzung/downloads.html�
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  Landkarte 
Wenn Sie auf diese Weise eine Landkartenbox auf das Arbeitsblatt bringen, können Sie später 
Schichten aus der Projektverwaltung oder aus der Kartenbibliothek ergänzen. Ändert sich die Grö-
ße der Landkartenbox, muss die Karte in der Regel neu eingepasst werden. Daher ist es sinnvoll, 
vor aufwendigen Arbeiten im Landkarten-Modus zunächst im Layout-Modus die endgültige Grö-
ße der Landkartenbox festzulegen. 

 

4.4 Grafikobjekte markieren 

RegioGraph bietet die üblichen Methoden, um Grafikobjekte bei aktivem Standardwerkzeug  für eine 
anschließende (gemeinsame) Bearbeitung (z.B. Verschieben, Löschen) zu markieren: 

 Ein einzelnes Objekt markiert man per Mausklick. 
 Bei gedrückter Umschalttaste   kann man kumulierend mehrere Objekte per Mausklick markieren. 

 Bei gedrückter Maustaste kann man einen Rahmen um alle zu markierenden Objekte ziehen. 
 Per Mausklick auf eine freie Arbeitsblattstelle hebt man die aktuellen Markierungen auf. 

 

4.5 Grafikobjekte bearbeiten 

4.5.1 Größe und Position 

Grafikobjekte, wozu auch die Landkartenboxen gehören, lassen sich im Layout-Modus auf Windows-
übliche Weise verschieben, verkleinern, vergrößern oder entfernen. Zum Löschen kann man die Entf-
Taste, den per Symbolleisten-Konfiguration (siehe Abschnitt 3.9) nachrüstbaren Symbolschalter , den 
Menübefehl Bearbeiten > Löschen oder das Kontextmenü verwenden. 
 

4.5.2 Formatieren 

Über das Format-Menü kann man den Formatieren-Dialog anfordern und in Abhängigkeit vom Typ 
der markierten Objekte verschiedene Attribute ändern: 

  Füllung 
Um eine Fläche (z.B. ein Rechteck) zu füllen, stehen Farben, Farbverläufe, Muster und Texturen 
bereit: 

 

Für eine Farbe oder einen Farbverlauf lässt sich der Transparenzgrad einstellen. 

Man ist nicht auf die angezeigte Farbpalette beschränkt, sondern kann nach einem Rechtsklick auf 
eine Farbzelle auch neue Farbtöne kreieren: 
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Wählen Sie bitte für die Box mit der Deutschlandkarte den folgenden Farbverlauf, wobei die End-
farben nach einem Mausklick auf die entsprechende Musterfläche  zu beeinflussen sind: 

 
Man übernimmt eine Gestaltung per Mausklick auf das grüne Häkchen in der unteren rechten 
Ecke. 

  Linie 
In der Formatieren-Dialogbox wählt man einen Linientyp für die markierten Objekte und über-
nimmt die Wahl per Mausklick auf das grüne Häkchen in der unteren rechten Ecke. Vor der Über-
nahme kann man die Breite und eine Farbe des Linientyps über die Werkzeuge am unteren Rand 
des Dialogs ändern, wobei am oberen Rand des Dialogs eine Vorschau angezeigt wird, z.B.: 

 

Weitaus mehr Gestaltungsmöglichkeiten bietet der folgende, über das Kontextmenü-Item Linien-
eigenschaften ändern erreichbare Dialog: 
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Ein Linientyp besteht aus maximal drei gestapelten Linien, die sich einzeln gestalten lassen. Über 
die Registerkarte Linienenden lassen sich z.B. Pfeilspitzen anbringen. Statt einen vorhandenen 
Linietyp zu ändern, kann man auch einen neuen Typ per Kontextmenü anlegen und dann gestal-
ten. 

Wählen Sie im Demoprojekt für den Rahmen um die zuvor markierte Überschrift (Verkehrssi-
cherheit 2006) eine Unsichtbare Linie, indem Sie diese Option markieren und dann auf das 
grüne Häkchen in der unteren rechten Ecke klicken: 

 

  Schrift 
Wählen Sie im Demoprojekt für die Überschrift die Schriftart Arial, den Stil Fett Kursiv, den 
Schriftgrad 40 sowie die Textfarbe Schwarz: 

 
Quittieren Sie Ihre Wahl per Mausklick auf das grüne Häkchen in der unteren rechten Ecke. 

Über den Menübefehl 

Format > Textausrichtung 

können Sie den Text innerhalb seiner Box horizontal und/oder vertikal ausrichten: 

 



 

 26 

Thematische Kartographie mit RegioGraph 11 
 

Mit dem Menübefehl 

Format > Ausrichten, Verteilen, Größe > Horizontal auf dem Arbeitsblatt zentrieren 

erreicht man das horizontale Zentrieren der gesamten Textbox in Bezug auf das Arbeitsblatt. 

  Schatten 
Wählen Sie für die Landkartenbox im Demoprojekt einen blauen Schatten, und quittieren Sie Ihre 
Wahl per Mausklick auf das grüne Häkchen in der unteren rechten Ecke: 

 

Nach dem Ergänzen und Formatieren eines Untertitels und einer Fußnote sollte das erste Arbeitsblatt des 
Demoprojekts ungefähr so aussehen: 

Baden-Württemberg

Hessen

Rheinland-Pfalz

Saarland

Schleswig-Holstein

Hamburg

Niedersachsen

Bremen

Nordrhein-Westfalen

Thüringen

Sachsen-Anhalt

Sachsen

Berlin

Brandenburg

Mecklenburg-Vorpommern

Bayern

Verkehrssicherheit 2006
(Unfalltote pro 1 Million Einwohner)

Quelle: Statistisches Bundesamt

 
Eventuell ist bei Ihrer Landkartenbox aufgrund einer Größenänderungen das Einpassen der Gebiets-
schicht erforderlich (siehe Abschnitt 6.5). 

Über die Symbolleiste Schnellformat sind wichtige Formatierungsoptionen besonders leicht erreichbar, 
z.B. 
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Über den bereits im Zusammenhang mit Symbolen (siehe Abschnitt 4.3) behandelten Menübefehl 

Format > Palette 

kann man die aktuelle Palette mit allen Eigenkreationen (z.B. Farben, Linientypen) speichern oder eine 
zuvor gespeicherte Palette laden. Ohne explizites Speichern gehen die Änderungen und Erweiterungen 
der Palette beim Beenden von RegioGraph verloren. Das Speichern in die Datei mit der Standardpalette 
erfordert Administratorrechte, ist also z.B. auf den ZIMK - Pool-PCs für Normbenutzer nicht möglich. 
Wählen Sie stattdessen zum Speichern eine Datei auf Ihrem persönlichen Laufwerk U:, z.B.: 

 
 

4.5.3 Eigenschaftsdialog 

Größe, Position und Attribute eines Objekts lassen sich auch über einen Eigenschaftsdialog ändern, der 
via Kontextmenü erreichbar ist, z.B. bei einer Landkartenbox: 
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4.5.4 Linien und Polygone editieren 

Bei einfachen Linien (nur ein Segment) lassen sich die Endpunkte per Maus anpacken und verschieben. 
Gehen Sie folgendermaßen vor, um eine Polylinie oder ein Polygon zu ändern: 

 Markieren Sie das zu verändernde Objekt. 
 Bei gedrückter Taste S können Sie einen Stützpunkt verschieben. 
 Bei gedrückter Taste A können Sie einen zusätzlichen Stützpunkt einfügen. 
 Bei gedrückter Taste D können Sie einen Stützpunkt löschen. 
 

4.5.5 Übertragung von Formaten 

Um die Formatattribute eines Quellobjekts (z.B. Hintergrundfarbe, Schatten oder Linientyp) auf ein Ziel-
objekt zu übertragen (sofern dort anwendbar), geht man folgendermaßen vor: 

 Quellobjekt markieren 
 Mit dem Menübefehl Format > Format Übertragen das Übertragungswerkzeug  aktivieren 
 Linker Mausklick auf das Zielobjekt 

Um das Übertragungswerkzeug  wieder los zu werden, reaktiviert man per Mausklick das Standardin-
strument . 

Wie sich Positions- und Größenattribute zwischen Objekten übertragen lassen, erfahren Sie in Abschnitt 
4.6. 
 

4.5.6 Objektstapelung verändern 

Sukzessiv am selben Ort erzeugte Objekte liegen in natürlicher Anordnung übereinander und überdecken 
sich dabei (teilweise). Mit dem Menübefehl 

Format > Reihenfolge 

kann ein markiertes Zeichnungselement im Stapel nach oben bzw. unten verschoben werden. 

In diesem Zusammenhang bietet der für Farben und Farbverkäufe einstellbare Transparenzgrad interes-
sante Gestaltungsmöglichkeiten, z.B.: 

 
 

4.6 Anpassungsmaßnahmen 

4.6.1 Grafikobjekte an einem Referenzobjekt ausrichten 

Über den Menübefehl 

Format > Ausrichten, Verteilen, Größe 

können Sie für eine Gruppe von simultan markierten Objekten dafür sorgen, dass alle ihre Position am 
zuletzt markierten Objekt orientieren: 
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  Linksbündig 

  Rechtsbündig 

  Oben ausrichten 

  Unten ausrichten 

  Horizontal zentrieren 
 Alle Objekte übernehmen die horizontale Position des zuletzt markierten Objekts. 

  Vertikal zentrieren 
 Alle Objekte übernehmen die vertikale Position des zuletzt markierten Objekts. 

 

4.6.2 Zentrieren in Bezug auf das Arbeitsblatt 

Mit dem Menübefehl 

Format > Ausrichten, Verteilen, Größe 

können Sie die markierten Grafikobjekte in Bezug auf das Arbeitsblatt horizontal oder vertikal zentrieren: 

  Horizontal auf dem Arbeitsblatt zentrieren 

  Vertikal auf dem Arbeitsblatt zentrieren 

 

4.6.3 Grafikobjekte verteilen 

Über den Menübefehl  

Format > Ausrichten, Verteilen, Größe 

können Sie für eine Gruppe von simultan markierten Objekten dafür sorgen, dass der Abstand vom ersten 
bis zum letzten Objekt in horizontaler oder vertikaler Richtung gleichmäßig aufgeteilt wird: 

  Horizontal verteilen 
Die Objekte am linken und rechten Rand der Gruppe behalten ihre Position. Alle anderen verän-
dern ihre horizontale Position so, dass die horizontalen Abstände zwischen allen Objekten gleich 
werden. 

  Vertikal verteilen 
Die Objekte am oberen und unteren Rand der Gruppe behalten ihre Position. Alle anderen verän-
dern ihre vertikale Position so, dass die vertikalen Abstände zwischen allen Objekten gleich wer-
den. 

 

4.6.4 Größe anpassen 

Über den Menübefehl  

Format > Ausrichten, Verteilen, Größe 

können Sie für eine Gruppe von simultan markierten Grafikobjekten dafür sorgen, dass alle ihre Größe an 
das zuletzt markierte Objekt anpassen: 

  Gleiche Breite 

  Gleiche Höhe 

  Gleiche Höhe / Breite 
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4.7 Grafikobjekte gruppieren 

Grafikobjekte, die (vorübergehend) gemeinsam behandelt (z.B. verschoben) werden sollen, steckt man 
am besten in eine Gruppe. Dazu markiert man alle Gruppenmitglieder und wählt dann den Menübefehl: 

Bearbeiten > Gruppieren > Gruppieren 

oder aus dem Kontextmenü zu einem markierten Objekt das Item Gruppieren. 

Um eine markierte Gruppe wieder in ihre Einzelbestandteile zu zerlegen, wählt man den Menübefehl: 

Bearbeiten > Gruppieren > Gruppierung aufheben 

oder aus dem Kontextmenü zur Gruppe das Item Gruppierung aufheben. 

Wer anstelle der Menübefehle die Symbolschalter  bzw.  zu Einrichten bzw. Aufheben einer Grup-
pierung verwenden möchte, muss diese per Symbolleisten-Konfiguration (siehe Abschnitt 3.9) nachrüs-
ten. 
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5 Mit Tabellen arbeiten 
Zu jeder RegioGraph-Kartenschicht gehört eine Tabelle, die z.B. per Doppelklick auf ihren Layer-Eintrag 
in der Projektverwaltung zu öffnen ist. Die Tabelle zur Gebietsschicht Bundesländer Deutschland 
2009 sieht im Auslieferungszustand so aus: 

 
Das Tabellenfenster belegt per Voreinstellung den gesamten Dokumentenbereich und überdeckt ggf. 
offene Arbeitsblattfenster, kann aber z.B. mit der Menüzeilen-Schaltfläche  zu mehr Bescheidenheit 
gezwungen werden. 

Jede Tabelle enthält mindestens die beiden folgenden, nicht löschbaren Spalten: 

 Identifikationsspalte 
In der ersten Spalte ist jedes geographische Objekt der Schicht durch einen eindeutigen Wert identifi-
ziert. 

 Gehört zu 
Diese Spalte wird beim Aggregieren von Objekten zu neuen Einheiten benötigt. 

Neben dem (veränderbaren) Titel besitzen die Tabellenspalten noch einen in Klammern angehängten 
Buchstabencode, der in Formeln zur Berechnung von Spaltenwerten (siehe unten) zu verwenden ist. 

Für die Einträge einer Tabellenspalte kommen folgende Datentypen in Frage: 

 Ganzzahl 
 Dezimalzahl 
 Text 
 

5.1 Daten in eine Layertabelle importieren 

RegioGraph kann aus folgenden Quellen neue Spalten in eine Layertabelle importieren: 

 Dateien 
Unterstützte Dateiformate: 

- MS-Access 
- MS-Excel 
- dBase  
- Textdateien 
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 Windows-Zwischenablage 
Aus der Windows-Zwischenablage können z.B. Text- oder Excel-Daten übernommen werden. 

 ODBC-Datenbanken 

Aus nahe liegenden Gründen muss die zu importierende Datenmatrix eine Identifikationsspalte enthal-
ten, die zusammen mit dem Gegenstück in der Layertabelle regelt, welchem Objekt eine Importzeile zu-
geordnet werden soll. 

Nach dem Menübefehl 

Datei > Import 

erscheint folgende Dialogbox, die den Import von Daten oder geographischen Objekten (Punkten oder 
Linien) in einen Layer sowie die Ausführung einer aufgezeichneten Importspezifikation (siehe unten) 
ermöglicht: 

 
Wir wählen hier die Option 

Daten in folgenden Layer einfügen: Bundesländer Deutschland 2009 

und machen dann weiter. 
 

5.1.1 Import aus einer Excel-Tabelle 

Beim ersten Datenimport greifen wir auf die mit RegioGraph ausgelieferten Kaufkraftdaten in der Excel-
Datei GfK_Kaufkraft_Deutschland_2009.xls zu, die nach einem Klick auf den Erweiterungsschalter 

 dank geeigneter Ordnervoreinstellung direkt wählbar sein sollte: 
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Verwenden Sie das zur Zieltabelle passende Excel-Tabellenblatt Bundesländer$: 

 

Anschließend wird die Übernahme von Spalten der Import-Tabelle in neue oder in bereits vorhandene 
Spalten der Layertabelle festgelegt: 

 
Zunächst wird über ein Paar von Abgleichspalten geregelt, welchem Objekt der Layertabelle eine Im-
portzeile zugeordnet werden soll: 

 Man zieht die Import-Abgleichspalte per Maus auf die Zelle links neben der Layer-Abgleichspalte 

 und klickt in der  - Spalte auf die Zeile zu diesem Paar. 

Im Beispiel ist die Importspalte code_reg mit der Layertabellenspalte Bundeslandkennziffer ab-
zugleichen: 
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Um eine Variable als Importspalte neu in die Tabelle aufzunehmen, setzt man einen Doppelklick auf 
ihren Namen, z.B.: 

 
Im Beispiel wurde die Spalte name_reg nicht importiert, weil sie mit der bereits vorhandenen Layer-
Spalte Bundesland identisch ist. Um eine Importspalte wieder zu entfernen, setzt man einen erneuten 
Doppelklick auf ihren Namen. 

Zur Übernahme in eine bereits vorhandene Tabellenspalte zieht man die zu importierende Spalte per 
Maus auf die Zelle links neben dem Ziel, wobei in der  - Spalte per Mausklick zwei Modi wählbar 
sind: 

 bisherige Werte überschreiben 

+ neue Werte zu den bisherigen addieren (nur möglich bei numerischen Variablen) 

Ist das Kontrollkästchen in der  - Spalte markiert, wird die Zielspalte vor dem Import geleert. Diese 
Spalte bietet im Vergleich zum Überschreibmodus keinen Nutzen, solange für jedes geographische Ob-
jekt in der Zieltabelle maximal eine Importzeile vorhanden ist, was aber nicht unbedingt der Fall sein 
muss. 

Sind für manche geographische Objekte (Zeilen der Zieltabelle) mehrere Importzeilen vorhanden, kann 
man deren Zahl über das Kontrollkästchen Zählspalte einfügen in einer Spalte mit frei wählbarem 
Namen ablegen lassen. Beim Mehrzeilenimport von numerischen Daten ist zu beachten: 
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 Beim Import im Überschreibmodus () gewinnt bei jedem geographischen Objekt die letzte Import-
zeile. 

 Beim Import im Additionsmodus (+) wird der Summenwert importiert. Was mit einem vor dem Im-

portieren vorhandenen Wert geschieht, regelt das Kontrollkästchen in der  - Spalte (siehe oben). 

Im nächsten Dialog geht es um die Reaktion auf Probleme bei der Zuordnung einer Importzeile oder beim 
Lesen der Daten: 

 
Erwartungsgemäß macht die mit RegioGraph gelieferte Importdatei keine Probleme: 

 

Lässt man die Importspezifikation in eine imp-Datei speichern, kann diese später zur automatisierten 
Wiederholung des aufgezeichneten Imports dienen. 

Nach dem erfolgreichen Import stehen in der Tabelle zur Bundesländer-Gebietsschicht zahlreiche Variab-
len zur Verfügung: 
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In der Excel-Importdatei GfK_Kaufkraft_Deutschland_2009.xls findet sich eine Dokumentation der 
Variablen. 
 

5.1.2 Import aus einer Textdatei 

Wir importieren aus der Textdatei bl1205.txt mit Tabulator-getrennten Werten weitere Merkmale in die 
Gebietstabelle der deutschen Bundesländer. Die Importdatei enthält u.a. Informationen zu den 16 Bundes-
ländern, die vom Statistischen Bundesamt im Rahmen der informationellen Grundversorgung zur Verfü-
gung gestellt wurden (© Statistisches Bundesamt, Wiesbaden 2010). Sie ist in diesem PDF-Dokument 
enthalten und kann mit dem Anzeigeprogramm Adobe Acrobat (Reader) nach dem Menübefehl 

Anzeige > Navigationsfenster > Anlagen 

per Maus (Ziehen und Ablegen) oder über den Schalter  entnommen werden: 

  

Wir starten erneut den Import-Assistenten mit dem Menübefehl 

Datei > Import 

und wählen im ersten Dialog wieder die Option 

Daten in folgenden Layer einfügen: Bundesländer Deutschland 2009 

Weil wir als Quelle eine Textdatei verwenden, 
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fragt der Import-Assistent im nächsten Dialog, welche Datenorganisation (Trennzeichen versus 
Spalten mit fester Breite) und welchen Zeichensatz diese Datei verwendet: 

 
Wir wählen die Option durch Trennzeichen getrennt sowie den westeuropäischen Zeichensatz 
und machen weiter. 

Im nächsten Dialog übernehmen wir das vorgeschlagene Trennzeichen Tabulator und teilen mit, dass 
der ersten Dateizeile die Spaltentitel zu entnehmen sind: 
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Nun schlägt der Import-Assistent Datentypen und Attribute für die zu importierenden Variablen vor, 
wobei nur selten Nachbesserungen nötig sind: 

 

Anschließend geht es bei der Übernahme von Spalten der Importdatei in neue oder in bereits vorhandene 
Spalten der Zieltabelle genauso weiter wie beim Import aus der Excel-Datei (siehe Abschnitt 5.1.1). Die 
Importspalte kennung ist mit der Tabellenspalte Bundeslandkennziffer abzugleichen: 

 
Übernehmen Sie per Doppelklick alle Importspalten außer name (identisch mit der Tabellenspalte Bun-
desland). 

Beim Abgleich trifft eine Layer-Textspalte auf eine Import-Ganzzahlspalte, wobei der Zahlenvergleich 
(= Voreinstellung) zu bevorzugen ist: 
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Wir machen noch einmal weiter und erhalten die Erfolgsmeldung: 

 
 

5.2 Spalten erstellen und modifizieren 

Die Werte in den Zellen von nicht gesperrten Spalten (siehe unten) können wie in vergleichbaren Win-
dows-Anwendungen (z.B. MS-Excel) geändert werden. Es ist z.B. möglich, ganze Spalten oder andere 
rechteckige Tabellenbereiche via Zwischenablage mit Werten zu versorgen. 

Die im Folgenden beschriebenen Bearbeitungsmöglichkeiten für Spalten sind in der Regel über das (per 
Maus-Rechtsklick erreichbare) Kontextmenü einer Spalte verfügbar. 
 

5.2.1 Neue Spalte erstellen 

Gehen Sie folgendermaßen vor, wenn Sie z.B. hinter der Spalte C eine neue Spalte einfügen wollen: 

 Wählen Sie die Option Neue Spalte aus dem Kontextmenü zur Spalte C. 
 Legen Sie in der folgenden Dialogbox einen Titel und einen Datentyp fest, z.B.: 
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Mit dem Kontrollkästchen Formatieren wird bei numerischen Spalten ein Tausendertrennzeichen 
aktiviert. 

 

5.2.2 Dialogfeld Spalteneigenschaften 

Über das Item Eigenschaften aus dem Kontextmenü zu einer Spalte ist folgender Dialog mit diversen 
Einstellungsmöglichkeiten erreichbar: 

Numerische Datentypen Datentyp Text 

  

Im Bereich Allgemein kann man … 

 den Titel der Spalte ändern 

 die Werte der Spalte in Landkarten mit einem Präfix und/oder Suffix anzeigen lassen 

 die Eingabe sperren, also Schreibschutz für eine Spalte vereinbaren 

 mehrzeilige Textspalten zulassen (nur bei Textspalten) 
Dies ist sinnvoll, wenn längere Bezeichnungen in Karten angezeigt werden sollen. 
Um in solchen Fällen die Texteingabe zu erleichtern, sollten Sie in den betroffenen Zeilen mehr Platz 
schaffen. Packen Sie dazu im Bereich der Zeilenbeschriftungen (am linken Tabellenrand) die betrof-
fenen Zeilengrenzen mit der Maus an, und stellen Sie eine geeignete Zeilenhöhe ein. 
Ein Zeilenumbruch wird per Enter-Taste erzeugt, z.B.: 
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 die maximale Länge von Textspalten-Einträgen ändern 

Es geht um die Gesamtzahl der Zeichen, wobei ein Zeilenwechsel zwei Zeichen belegt. 

Im Bereich Zahlenformat kann man bei numerischen Spalten das Tausendertrennzeichen aktivie-
ren und bei Spalten vom Typ Dezimalzahl zusätzlich die Anzahl der Dezimalstellen wählen: 

 

In der Abteilung Berechnung und Darstellung 

 
kann man bei numerischen Spalten … 

 verschiedene Varianten für die Darstellung der Werte in der Tabelle und in Landkarten anfordern, 
z.B. absolute Werte, absolute Abweichung vom Mittelwert, Prozent der Summe. Dabei ist mit absolut 
ist das Gegenteil von prozentual gemeint, so dass bei dieser Darstellung auch negative Werte auftre-
ten können. Statt Zahlen kann man in einer Tabellenspalte auch Balken anzeigen lassen, z.B. Balken 
mit der Mittelwertsabweichung für die in Abschnitt 5.1 importierte Variable UNFREL3 mit der An-
zahl der Verkehrstoten pro 1 Million Einwohner: 
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 die Werte einer Spalte über eine Formel berechnen lassen 
Bei Ganzzahl- und Dezimalspalten können Sie bei Berechnungsart die Voreinstellung keine 
durch Formel ersetzen und dann einen arithmetischen Ausdruck angeben. Im folgenden Beispiel 
(neue Spalte GSREL) wird für die deutschen Bundesländer die prozentuale biologische Änderung der 
Einwohnerzahl berechnet ((Geburten – Sterbefälle)/Einwohner*100): 

 
In dem arithmetischen Ausdruck dürfen Sie verwenden: 

- Buchstabencode von Spalten 
Eine abgeleitete Spalte reagiert dynamisch auf spätere Wertänderungen bei einer Quellspalte. 
Weil intern eindeutige Spaltennamen verwendet werden, wirken sich spätere Änderungen bei 
der Spaltenreihenfolge (siehe unten) nicht aus. 

- Numerische Konstanten 
- Die Operatoren Addition (+), Subtraktion (-), Division (/) und Multiplikation (*) 
- Klammern 
- Funktionsnamen, z.B. SQRT(), POW() 
- Verzweigung (IF) 

Nähere Informationen zu den Funktionen und zur Verzeigung finden Sie in der Hilfe über 

Inhalt > APPENDIX - Formelsyntax 

In der Abteilung Schrift und Farben 
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kann man … 

 die Farben für Balkendarstellungen ändern (siehe oben) 
 die Schriftart, -größe und -farbe für die Wertanzeige in der Tabelle ändern. 

 

5.2.3 Weitere Modifikationen einer Tabelle 

Um die Breite einer Spalte zu verändern, .... 

 klickt man auf den rechten Rand ihrer Kopfzelle, 
 bewegt bei gedrückter Maustaste den (optisch veränderten) Mauszeiger bis zum neuen rechten Rand 
 und lässt die Maustaste wieder los. 

Um eine Spalte zu verschieben, öffnet man per Kontextmenüoption Tabellenstruktur die folgende 
Dialogbox  

 
und bewegt die markierte Spalte mit den grünen Transportschaltern. Mit diesem Dialog lasen sich auch 
Spalten anlegen oder löschen. 

Um Spalten aus- oder einzublenden, öffnet man über das Item Ein-/Ausblenden aus dem Kontextme-
nü zu einer beliebigen Tabellenspalte die folgende Dialogbox 

 
und sorgt für passende Markierungen. 
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Man kann die Zeilen einer Tabelle per Kontextmenü auf- oder absteigend nach einer Spalte sortieren 
lassen. 

 
Für eine komplexere Sortierung fordert man über die Kontextmenüoption Sortieren > nach mehreren 
Spalten die folgende Dialogbox an, z.B.: 

 

Um den Wert einer bestimmten Zelle eines markierten Bereiches auf alle anderen markierten Zellen zu 
übertragen, wählt man aus dem Kontextmenü zur Quellzelle die Option Auffüllen. So lassen sich z.B. 
die Zellen einer neuen Spalte bequem mit einem geeigneten Initialisierungswert versorgen: 

Neue Spalte anlegen und ge-
wünschten Initialisierungswert in 

die erste Zeile eintragen: 

Gesamte Spalte markieren (z.B. 
per Mauklick auf die 
Spaltenbeschriftung): 

Kontextmenü zur Quellzelle 
öffnen und Auffüllen: 

   

Auch das Löschen einer Spalte ist per Kontextmenü möglich. 
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6 Landkartenbearbeitung 
In diesem Abschnitt werden Techniken zur Kartenbearbeitung beschrieben, die unabhängig von den dar-
zustellenden Tabellendaten durchgeführt werden (z.B. Gebiete ausblenden, Maßstab ändern, Beschriftun-
gen der geographischen Objekte anpassen). Diese Maßnahmen dienen meist zur Vorbereitung der Kar-
tengrundlage für die anschließenden Merkmalsvisualisierungen. Um vom Layout- in den Kartenbearbei-
tungsmodus zu gelangen, setzt man einen Doppelklick auf die zu bearbeitende Karte. 
 

6.1 Tipps zur Vermeidung von Ärger 

Im Landkarten-Modus ist der Menübefehl 

Bearbeiten > Rückgängig 

nicht immer wirksam. Z.B. kann das Verschieben einer Karte mit dem  -Werkzeug (siehe unten) nicht 
rückgängig gemacht werden. Bei Beachtung der folgenden Tipps sollte die Landkartenbearbeitung aber 
trotzdem ohne großen Ärger verlaufen: 

Glücklich, wer beizeiten sichert! 
Wer vor jeder kritischen Kartenbearbeitung den aktuellen Zustand sichert, hat eine einfache Möglichkeit, 
misslungene Änderungen rückgängig zu machen: 

 Projekt schließen ohne Sichern 
 Projekt neu öffnen 

Das regelmäßige Sichern (z.B. alle 15 Minuten) ist generell empfehlenswert, zumal RegioGraph keine 
automatische Sicherung vornimmt. 

Die Geister, die ich rief ... 
Bei den im Abschnitt 6 beschriebenen Verfahren wird in der Regel ein spezieller Bearbeitungsmodus 
eingeschaltet, der u.a. durch eine spezielle Funktion und Gestalt des Mauszeigers gekennzeichnet ist. Z.B. 
hat im Verschiebungsmodus der Mauszeiger die Gestalt , und jede Mausbewegung bei gedrückter lin-
ker Maustaste verschiebt die Karte (ohne Möglichkeit zur Rücknahme). Gelegentlich ist es sinnvoll, ei-
nen speziellen Bearbeitungsmodus zu beenden, um unbeabsichtigte Mauseffekte zu vermeiden. Dazu 
reaktiviert man per Mausklick auf den Symbolschalter  oder mit dem Menübefehl1 

Bearbeiten > Auswählen > Auswählen 

das Standardinstrument, das als unbeabsichtigte Aktion lediglich eine harmlose Markierung verursachen 
kann. 

Kleiner Schalter, große Wirkung 
Bei aufwendigen Landkartenbearbeitungen schafft es RegioGraph nicht immer, die Bildschirmanzeige 
aller Details auf aktuellem Stand zu halten. Daher ist es gelegentlich nötig, die Anzeige mit dem Schalter 

 (Symbolleiste Standard) zu aktualisieren. 
 

6.2 Karteninhaltsfenster und Arbeitslayer 

Mit dem Landkarten-Modus wird auch das Fenster Karteninhalt  aktiv und zeigt alle Schichten der ak-
tuellen Karte an. Da unsere Karte derzeit nur eine Schicht enthält, übernehmen wir der Übung halber aus 
der Kartenbibliothek noch die Schicht Städte über 100.000 Einwohner in die Projektverwaltung und 
die Karte. 

                                                 
1 Der Menübefehl bietet sich insbesondere dann an, wenn der Symbolschalter  unauffindbar ist. 
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Es kann jeweils nur ein Layer bearbeitet werden. Dieser Arbeitslayer ist im Karteninhaltsfenster an einer 
unterstrichenen Bezeichnung zu erkennen. Durch einen Klick auf den entsprechenden Eintrag im Karten-
inhaltsfenster machen wir Bundesländer Deutschland 2009 zum Arbeitslayer: 

 

Um eine Schicht aus der aktuell bearbeiteten Karte (nicht aus dem Projekt) zu entfernen, wählt man aus 
ihrem Kontextmenü im Karteninhaltsfenster die Option Entfernen. 

Über das Kontrollkästchen links neben ihrem Namen lässt sich eine Schicht aus- bzw. einblenden. Eine 
ausgeblendete Schicht bleibt in der Karte mit ihren spezifischen Einstellungen (z.B. Maßstab) erhalten, 
während eine entfernte Schicht bei einer späteren Neuaufnahme keine Erinnerung mehr an ihren früheren 
Einsatz in der Karte hat. 

Es kann durchaus sinnvoll sein, eine Schicht mehrfach auf eine Karte zu legen, um auf den einzelnen 
Instanzen verschiedene Visualisierungstechniken einzusetzen (siehe unten). 

Die für den Gesamteindruck der Karte sehr wichtige Reihenfolge der Schichten kann im Karteninhalts-
fenster durch Ziehen und Ablegen mit der Maus (Drag & Drop) geändert werden. 

Über das Item Eigenschaften im Kontextmenü zum Arbeitslayer lässt sich eine Tabelle (de)aktivieren, 
mit der das Verhalten des Arbeitslayers auf vielfältige Weise beeinflusst werden kann, z.B.: 

 

Die Werte der Quickinfospalten werden im Landkarten-Modus angezeigt, sobald der Mauszeiger bei 
aktiver Quickinfo-Anzeige über einem geographischen Objekt verweilt, z.B.: 

 
Dabei werden alle Layer berücksichtigt, also nicht nur der Arbeitslayer. (De)Aktivieren läst sich die 
Quickinfo-Anzeige (im Landkarten-Modus) über den Menübefehl 
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 Landkarte > Quickinfo anzeigen 

Mit der Layer-Eigenschaft Objekte zeigen wird festgelegt, in welchem Maßstabsbereich eine Schicht 
angezeigt werden soll. Analog lässt sich die Anzeige der Objektbeschriftungen vom Maßstab der Karte 
abhängig machen. Für die Städteschicht wird im Beispiel eingestellt, dass die Beschriftungen nur bei ei-
nem Maßstab kleiner oder gleich 1:500.000 erscheinen sollen. 

Durch Mausklicks bei gedrückter Strg-Taste lassen sich im Karteninhaltsfenster Infolayer (ab)wählen, 
deren Objekte bei den in Abschnitt 6.8 beschriebenen Informationsmethoden per Voreinstellung berück-
sichtigt werden, z.B.: 

 

Mit der Erstellung neuer, leerer Layer beschäftigen wir uns in Abschnitt 6.14. 
 

6.3 Ausschnitt wählen 

Aktivieren Sie über den Menübefehl 

Landkarte > Zoom + 

oder mit dem positiven Zoom-Symbol  auf der Symbolleiste Kartenfunktionen das Ausschnitts-
werkzeug , und wählen Sie einen Ausschnitt, der nur die neuen Bundesländer umfasst: 

chleswig-Holstein

Hamburg

ersachsen

Thüringen

Sachsen-Anhalt

Sachsen

Berlin

Brandenburg

Mecklenburg-Vorpommern

 
Während Sie per Maus das Ausschnittsrechteck festlegen, werden seine Seitenlängen in der Statuszeile 
angezeigt (in km). 

Die Zoom-Funktion lässt sich natürlich auch auf bereits vergrößerte Ausschnitte anwenden. Wählen Sie 
so einen Ausschnitt, der nur Brandenburg und Berlin umfasst. 

Wechseln Sie über den Menübefehl 
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Landkarte > Zoom - 

oder mit einem Mausklick auf das negative Zoom-Symbol  (Symbolleiste Kartenfunktionen) zurück 
zur vorherigen Zoom-Stufe (neue Bundesländer). 

Nach einer Ausschnittsveränderung macht man gern von der RegioGraph-Option Gebrauch, eine Karte 
mit dem -Werkzeug unter dem Kartenfenster zu verschieben. 

Die in diesem Abschnitt beschriebenen Methoden verändern eine Landkartenbox, indem sie die geogra-
phischen Koordinaten der linken oberen Kartenecke sowie den Maßstab neu festlegen. Im Unterschied 
dazu wird über den in Abschnitt 3.9 vorgestellten Menübefehl 

Ansicht > Zoom Arbeitsblatt 

bzw. über das Steuerelement  auf der Standard-Symbolleiste lediglich die Anzeige des Ar-
beitsblatts beeinflusst. 

In Abschnitt 6.10.1 lernen Sie ein Werkzeug kennen, das die numerische Eingabe eines Maßstabs erlaubt. 
 

6.4 Geographische Objekte markieren 

6.4.1 Markieren im Landkarten-Modus 

Viele Arbeiten im Landkarten-Modus (z.B. Ausblenden von Objekten, Formatieren der Beschriftung) 
sollen nur für bestimmte Objekte ausgeführt werden. Daher bietet RegioGraph zahlreiche Werkzeuge zum 
Markieren von Objekten. Machen Sie nötigenfalls im Demoprojekt die Bundesländerschicht zum Arbeits-
layer, wählen Sie einen Kartenausschnitt mit den südwestlichen Bundesländern, aktivieren Sie das Stan-
dardinstrument zum Markieren einzelner Objekte über sein Symbol  in der Standard-Leiste oder über 
den Menübefehl 

Bearbeiten > Auswählen > Auswählen 

und klicken Sie nacheinander bei gedrückter Umschalttaste   auf die Bundesländer Rheinland-Pfalz, 
Saarland und Baden-Württemberg. Das Ergebnis: 

 
Bei gedrückter linker Maustaste kann man ein Rechteck aufziehen, um alle (mit einem wesentlichen Flä-
chenanteil) tangierten Gebiete auszuwählen. 



 

 49 

Thematische Kartographie mit RegioGraph 11 
 

Um die Markierung eines Gebietes aufzuheben, klickt man es mit dem Standardinstrument  erneut an. 
Sollen dabei die Markierungen anderer Gebiete erhalten bleiben, ist zusätzlich die Umschalttaste   zu 
drücken. 

Per Mausklick auf das kleine Dreieck neben dem Standardinstrument  erhält man ein Menü mit weite-
ren Möglichkeiten, geographische Objekte zu markieren, und die zuletzt benutzte Option ist anschließend 
im Steuerelement direkt wählbar, z.B. . Analog arbeitende Kombinations-Steuerelemente werden 
Ihnen in RegioGraph noch oft begegnen. Die folgende Auswahl von Werkzeugen zum Markieren von 
geographischen Objekten 

  Auswählen mit Kreis 

  Auswählen mit Polygon 

  Alles auswählen Strg+A 

  Auswahl aufheben Strg+M 

  Auswahl umkehren 

ist auch über den Menübefehl 

Bearbeiten > Auswählen 

verfügbar. 

Die beschriebenen Markierungstechniken können in Schichten beliebigen Typs auf die dortigen Objekte 
angewendet werden. 

Nach dem Menübefehl 

Landkarte > Selektion 

können Sie mit Hilfe der folgenden Dialogbox alle Objekte markieren, die einer Bedingung genügen: 

 
Im Beispiel werden die neuen Bundesländer (inkl. Berlin) und das ebenfalls etwas später dazu gekomme-
ne Saarland markiert. 

Wie man das Tabellenfenster einer Schicht zum Markieren von geographischen Objekten verwendet, er-
fahren Sie im nächsten Abschnitt. 
 

6.4.2 Markieren im Tabellenmodus 

Durch das Markieren einer Tabellenzeile wird auch das zugehörige geographische Objekt markiert und 
umgekehrt, so dass Sie je nach Situation die bequemere Markierungsmethode wählen können. 
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Eine einzelne Tabellenzeile wird durch einen Mausklick auf ihre Zeilenbeschriftung markiert. Durch er-
neutes Anklicken lässt sich eine einzelne Markierung wieder beseitigen. Um einen Zeilenbereich zu mar-
kieren, überstreicht man bei gedrückter Maustaste die Zeilennummernspalte mit dem Mauszeiger. Durch 
die beschriebenen Mausaktionen lassen sich sukzessive auch mehrere, durch Lücken getrennte, Blöcke 
markieren. 

Auch im Tabellenmodus stehen über den Menübefehl 

Bearbeiten > Auswählen 

bzw. das Steuerelement1  auf der Symbolleiste Standard etliche weitere Markierungsoptionen zur 
Verfügung: 

  Alles auswählen Strg+A 

  Auswahl aufheben Strg+M 

  Auswahl umkehren 

  Auswahl nach oben 
Die markierten Zeilen werden an den Anfang der Tabelle verschoben. 

  Auswählen bis oben 
Beginnend mit dem aktuellen Aufenthaltsort der Zellenmarkierung werden alle Zeilen bis zum 
Anfang der Tabelle markiert. 

  Auswählen bis unten 
Beginnend mit dem aktuellen Aufenthaltsort der Zellenmarkierung werden alle Zeilen bis zum 
Ende der Tabelle markiert. 

 

                                                 
1 Per Mausklick auf das kleine Dreieck erscheint ein Menü mit den verschiedenen Markierungswerkzeugen. Das zuletzt 

benutzte Werkzeug ist anschließend im Steuerelement direkt anwählbar. 
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6.5 Landkarte einpassen 

RegioGraph kann die markierten Objekte, den Arbeitslayer oder die gesamte Karte optimal in die Land-
kartenbox einpassen, wobei die Karte verschoben und ein geeigneter Maßstab gewählt wird. Markieren 
Sie das Bundesland Brandenburg, und fordern Sie die optimale Einpassung über den Menübefehl 

Landkarte > Einpassen > Ausgewählte Objekte einpassen 

oder das Steuerelement1  auf der Symbolleiste Kartenfunktionen an. Das Ergebnis: 

 

Passen Sie die gesamte Karte ein mit: 

Landkarte > Einpassen > Landkarte einpassen 

Dieses Kommando bietet offenbar eine Möglichkeit, alle Ausschnittsveränderungen in einem Schritt 
rückgängig zu machen. 
 

6.6 Aus- und Einblenden von geographischen Objekten 

Oft werden Sie die Objekte einer RegioGraph-Kartenschicht nur teilweise benötigen, z.B. vom Gebiets-
layer Bundesländer Deutschland 2009 nur die neuen Bundesländer:2 

                                                 
1 Per Mausklick auf das kleine Dreieck im Kombinations-Steuerelement erscheint ein Menü, das auch die Einpassung des 

Arbeitslayers oder der gesamten Karte erlaubt. Die zuletzt benutzte Option ist anschließend im Steuerelement direkt an-
wählbar. 

2 Bei dieser Karte aus dem Demoprojekt ist die Punkteschicht mit den Städten ausgeblendet. 
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Thüringen

Sachsen-Anhalt

Sachsen

Berlin

Brandenburg

Mecklenburg-Vorpommern

 
Um solche Effekte zu erreichen bzw. zu entfernen, blendet man einzelne Objekte aus- bzw. ein. Im Land-
karten-Modus sind über den Menübefehl 

Landkarte > Ein-/Ausblenden 

und den korrespondierenden Schalter1  folgende Optionen verfügbar: 

  ausblenden 
Alle markierten Objekte werden ausgeblendet. 

  einblenden 
Alle markierten Objekte werden eingeblendet. Da ausgeblendete Objekte auf der Karte nicht mehr 
zu sehen sind, klappt das Markieren zum anschließenden Einblenden am besten im Tabellenfens-
ter (siehe Abschnitt 6.4.2). 

  alles einblenden 
Alle Objekte werden eingeblendet. 

  alles ausblenden außer 
Alle Objekte mit Ausnahme der markierten werden ausgeblendet. 

 

6.7 Beschriftungen 

Bei den Beschriftungen der Arbeitslayerobjekte lassen sich Inhalt, Positionen und Schriftattribute festle-
gen. 

6.7.1 Umfang und allgemeine Positionierung 

Über den Menübefehl 

Landkarte > Beschriftung 

bzw. Symbole auf der Beschriftungs-Symbolleiste können Sie Einstellungen vornehmen, die für alle 
markierten geographischen Objekte im Arbeitslayer gelten sollen: 

                                                 
1 Per Mausklick auf das kleine Dreieck erscheint ein Menü mit den anschließend beschriebenen Optionen. Die zuletzt be-

nutzte Option ist im Schalter direkt anwählbar. 
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  Beschriftung einblenden 

  Beschriftung ausblenden 

  Überlappung verhindern 
Zur Vermeidung von Überlappungen werden manche Beschriftungen ausgeblendet. Über den 
Schalter  werden alle Beschriftungen (re)aktiviert. 

  Beschriftung einstellen 
Auf der Registerkarte Spalten der folgenden Dialogbox wählt man diejenigen Variablen aus der 
Tabelle zum Arbeitslayer, deren Werte zur Beschriftung verwendet werden sollen, z.B.: 

 
Auf der Registerkarte Ausrichtung geht es um die Positionierung von Beschriftungen. 

 
Als Art der Ausrichtung kommen in Frage: 

 Frei verschiebbar 
Dabei werden  zuvor manuell veränderte Positionen (siehe unten) beim Quittieren der Dia-
logbox respektiert und nicht (wie bei den Varianten Am Objekt ausgerichtet und An 
Linie ausgerichtet) durch Standardwerte ersetzt. 

 Frei verschiebbar mit Linie 
Der einzige Unterschied zur ersten Option besteht darin, dass für eine nicht in Normalposi-
tion befindliche Beschriftung eine Verbindungslinie zur Normalposition gezeichnet wird. 

 Am Objekt ausgerichtet 
Die Beschriftungspositionen orientieren sich an den Objekten. Bei einer Punkteschicht 
kann man über das folgende Steuerelement 

 
eine Ausrichtung wählen. Bei einer Gebietsschicht bleibt die gewählte Ausrichtung ohne 
Folgen. 
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 An Linie ausgerichtet 
Diese Option steht nur bei Linienschichten zur Verfügung, z.B.: 

 
Mit dem Steuerelement Spaltenwerte legt man die Textausrichtung von mehrzeiligen Beschrif-
tungen fest (Optionen: linksbündig, rechtsbündig, zentriert). 
Über den Schalter Erweitert sind zusätzliche Optionen verfügbar: 

 
Hier kann man z.B. den Schriftwinkel einstellen und die Verbindungslinie zwischen Objekt 
und Beschriftung gestalten. Mit dem Beschriftungsabstand beeinflusst man die Wiederho-
lungsfrequenz bei mehrfach zu beschriftenden Objekten, was wohl nur für Linien relevant ist, 
z.B.: 

Beschriftungsabstand 0 mm (kein Eingriff) Beschriftungsabstand 200 mm 

  
Außerdem lässt sich die Überlappungskontrolle zwischen dem Layer-internen und dem Layer-
übergreifenden Modus umschalten). 

  Beschriftungen automatisch anordnen 
Wird die folgende Dialogbox bei einer aktiven Punkteschicht mit OK quittiert, 
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dann werden die Beschriftungen nach Möglichkeit so verschoben, dass keine Überlappungen auf-
treten, z.B.: 

Vor der Anwendung Nach der Anwendung 

  
Der Schalter  fehlt im Originalzustand der Symbolleiste Beschriftung, kann aber per Symbol-
leistenkonfiguration nachgerüstet werden (siehe Abschnitt 3.9). 

 

6.7.2 Individuelle Positionierung 

So können Sie die Beschriftung eines geographischen Objekts auf dem Arbeitslayer verschieben: 

 Aktivieren Sie nötigenfalls das Standardwerkzeug . 

 Halten Sie die Strg-Taste gedrückt. 
Bei einigen Schichttypen lassen sich mit gedrückter Strg-Taste auch die Objekte selbst verschieben. 
Daher zeigt RegioGraph über die Zeigerform an, was verschoben wird: 

 
 Verschieben Sie die Beschriftung mit gedrückter linker Maustaste. 

Um eine Beschriftung mit dem Standardwerkzeug  zu drehen, hält man die Strg- und die Umschalttas-
te   gedrückt. 
 

6.7.3 Schriftart und Schriftattribute 

RegioGraph produziert per Voreinstellung sehr kleine Beschriftungen, vermutlich zur Vermeidung von 
Überlappungen. Über den Menübefehl 

Format > Schrift 

bzw. mit dem Steuerelement1  auf der Symbolleiste Formatieren kann man für die Beschriftungen 
der markierten Objekte auf dem Arbeitslayer eine Schriftart und Schriftattribute einstellen, z.B.: 

                                                 
1 Per Mausklick auf das kleine Dreieck erscheint ein Menü mit Attributkategorien, und die zuletzt benutzte Option ist im 

Steuerelement direkt anwählbar. 
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6.8 Informationen zu geographischen Objekten abrufen 

Die Tabelle zu einer Kartenschicht enthält zu jedem geographischen Objekt verschiedene Informationen 
(mindestens eine Kennung und/oder eine Bezeichnung). Über den Menübefehl 

Landkarte > Infos abrufen 

bzw. über das Steuerelement1  in der Symbolleiste Kartenfunktionen kann man den Infomodus in 
Verbindung mit unterschiedlichen Auswahlwerkzeugen aktivieren, um anschließend Informationen zu 
geographischen Objekten abzurufen: 

  Infos abrufen 
Anschließend kann man per Mausklick auf ein geographisches Objekt im Auswahlfenster seine 
Daten anzeigen lassen, z.B.: 

 
Im Auswahlfenster legt man über Kontrollkästchen fest, ... 

o welche Layer berücksichtigt werden sollen, 
Voreinstellung: Die im Karteninhaltsfenster (per Mausklick bei gedrückter Strg-Taste) 
gewählten Infolayer (siehe Abschnitt 6.2) 

o welche Spalten einer Layertabelle angezeigt werden sollen. 

Bei gedrückter Umschalttaste   kann man mehrere Objekte kumulierend markieren. Zieht man 
per Maus ein Auswahlrechteck auf, dann erscheinen Informationen zu allen angesprochenen Ob-
jekten. Offenbar nimmt RegioGraph ein Gebiet in die Tabelle auf, wenn ein wesentlicher Anteil 
seiner Fläche im Auswahlrechteck liegt. 

  Infos abrufen mit Kreis 
Anschließend kann man per Auswahlkreis festlegen, zu welchen Objekten Daten im Auswahl-
fenster angezeigt werden sollen. Offenbar nimmt RegioGraph ein Gebiet in die Tabelle auf, 
wenn ein wesentlicher Anteil seiner Fläche im Auswahlkreis liegt. Die statistischen Berechnungen 
im unteren Teil des Auswahlfensters 

                                                 
1 Per Mausklick auf das kleine Dreieck erscheint ein Menü mit den anschließend beschriebenen Optionen. Die zuletzt be-

nutzte Option ist im Schalter direkt anwählbar. 
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erhält man über den Schalter  (Layerstatistik ein/aus). 

  Infos abrufen mit Polygon 
Anschließend kann man durch freihändiges Abgrenzen einer beliebigen Zone die Daten zu allen 
darin befindlichen Objekten anfordern. Wie bei der Kreisauswahl wird ein Gebiet aufgenommen, 
sobald ein wesentlicher Anteil seiner Fläche in der Auswahlzone liegt. 

  Objekte im Gebiet 
Ist der Arbeitslayer eine Gebietsschicht, erhält man Informationen zu allen Objekten aus interes-
sierenden Schichten, die sich im gewählten Gebiet befinden, z.B.: 

 
Hier wurden die beiden Tabellen (für Städte bzw. Bundesländer) mit dem Schalter  unterein-
ander angeordnet. 

  Objekte im Umkreis 
Anschließend kann man per Mausklick Informationen zu allen Objekten relevanter Schichten im 
Umkreis mit einem bestimmten Radius um die Klickstelle abrufen, z.B.: 

 
Wie man den Umkreisradius festlegt, ist gleich zu erfahren. 

  Objekte im Puffer 
Ist ein Linienlayer aktiv, kann man anschließend per Mausklick Informationen zu allen Objekten 
relevanter Schichten in einem Korridor bestimmter Breite um die gewählte Strecke abrufen. Wie 
man die Pufferbreite festlegt, ist gleich zu erfahren. 

  Objekte innerhalb einer Fahrdistanz (nur RegioGraph Planung) 
Anschließend kann man per Mausklick Informationen zu allen Objekten relevanter Schichten in-
nerhalb einer bestimmten Fahrdistanz ab Klickstelle abrufen. Wie man die Fahrstrecke festlegt, ist 
gleich zu erfahren. 
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  Objekte innerhalb einer Fahrzeit (nur RegioGraph Planung) 
Anschließend kann man per Mausklick Informationen zu allen Objekten relevanter Schichten in-
nerhalb einer bestimmten Fahrzeit ab Klickstelle abrufen. Wie man die Fahrzeit festlegt, ist gleich 
zu erfahren. 

  Einstellungen 
Im folgenden Dialog legt man den Radius für die Funktion Objekte im Umkreis, die Korridor-
breite für die Funktion Objekte im Puffer, die Fahrdistanz für die Funktion Objekte inner-
halb einer Fahrdistanz sowie die Fahrzeit für die Funktion Objekte innerhalb einer Fahr-
zeit fest: 

 
 

6.9 Entfernungen messen 

RegioGraph kann die Entfernung entlang einer Polylinie messen: 

 Wählen Sie den Menübefehl Landkarte > Entfernungen. 
 Klicken Sie auf den Startpunkt, danach auf alle Zwischenstationen und schließlich auf den Zielpunkt. 

Der aktuelle km-Stand wird während der Reise angezeigt, z.B.: 
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6.10 Geographische Orientierungshilfen für Landkarten 

6.10.1 Maßstab eintragen 

Nach dem Menübefehl 

Landkarte > Maßstab 

können Sie mit der folgenden Dialogbox den Maßstab einer Karte anzeigen lassen und/oder verändern: 

 
Auf den im Feld Aktueller Wert sicht- und modifizierbaren Maßstab wirken sich z.B. die Zoom-
Funktion (siehe Abschnitt 6.3) und das Einpassen (siehe Abschnitt 6.5) aus. 

Der eingeblendete Maßstabsbalken kann mit dem Standardinstrument  markiert und anschließend hin-
sichtlich Position und Größe verändert werden, wobei RegioGraph eine Größenänderung bei der Maß-
stabsangabe berücksichtigt, z.B.: 

N

50 km

 
Wenn die Wahl eines Kartenausschnitts (vgl. Abschnitt 6.3) bzw. das Einpassen einer Karte oder ihrer 
markierten Objekte (vgl. Abschnitt 6.5) nicht zum gewünschten Maßstab führt, kann über die numerische 
Eingabe in der Dialogbox Maßstab nachgebessert werden. 
 

6.10.2 Nordpfeil eintragen 

Nach dem Menübefehl 

Landkarte > Nordpfeil 
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können Sie mit der folgenden Dialogbox einen Nordpfeil anzeigen lassen und/oder verändern: 

 
Der eingeblendete Nordpfeil kann mit dem Standardinstrument  markiert und anschließend hinsichtlich 
Position und Größe verändert werden (siehe Abbildung im letzten Abschnitt). 
 

6.10.3 Gitternetz anzeigen 

Nach dem Menübefehl 

Landkarte > Gitternetz 

kann man in der folgenden Dialogbox 

 
Gitterlinien mit den Längen- und Breitengraden anfordern, z.B.: 

6°

6°

6° 30'

6° 30'

7°

7°

7° 30'

7° 30'

8°

8°

8° 30'

8° 30'

49°

49° 30'

49° 30'

50°

50°

50° 30'

50° 30'

N

50 km
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6.11 Perspektive wählen 

Über den Menübefehl 

Landkarte > Perspektive 

ist ein Werkzeug zur Wahl der Perspektive verfügbar, wobei im Kontrollgitter zur Orientierung der untere 
Kartenrand rot hervorgehoben ist: 

 

Um das Werkzeug in einem selbständigen Fenster zu erhalten, trennt man es vom Menüitem: 

 

Ein Perspektivenwechsel macht eine Karte nicht unbedingt übersichtlicher, eignet sich aber zur optischen 
Betonung wichtiger Objekte, z.B.: 

 
 

6.12 Projektion einstellen 

Zur Umrechnung der geographischen Koordinaten, die von der annähernd kugelförmigen Erdoberfläche 
stammen, auf eine zweidimensionale Karte stehen diverse Projektionsmethoden zur Wahl, die sich auf die 
Erhaltung verschiedene Aspekte (z.B. Flächen, Längen, Winkel) konzentrieren. Über den Menübefehl 

Landkarte > Projektion 

lässt sich die Projektion im folgenden Dialog einstellen, z.B.: 
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6°

6°

6° 30'

6° 30'

7°

7°

7° 30'

7° 30'

8°

8°

8° 30'

8° 30'

49°

49°

49° 30'

49° 30'

50°

50°

50° 30'

50° 30'

51°

51°
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6°

6°

6° 30'

6° 30'

7°

7°

7° 30'

7° 30'

8°

8° 8° 30'

49°

49°

49° 30'

49° 30'

50°

50°

50° 30'

50° 30'

51°

51°

50 km

 
 

6.13 Region kopieren und einfügen 

Wenn von einem Gebietslayer nur wenige Objekte einbezogen werden sollen, und weitere, detailreiche 
Schichten (z.B. ein Punktelayer mit Städten) benötigt werden, ist das Ausblenden von irrelevanten Objek-
ten auf den Zusatzschichten mühsam. Man kann diese Fleißarbeit folgendermaßen vermeiden: 

 Auf dem Gebietslayer werden die erwünschten Objekte markiert. Auf den zusätzlichen Layern dür-
fen alle Objekte eingeblendet sein. 

 Mit dem Menübefehl 

Landkarte > Region kopieren 

wird eine Karte mit passend ausgeblendeten Objekten in die Windows-Zwischenablage kopiert. 
 Man legt eine leere Landkartenbox an (z.B. mit dem Menübefehl Einfügen > Landkarte), die sich 

anschließend im Kartenbearbeitungsmodus befindet. 

 Mit dem Menübefehl 

Landkarte > Region einfügen 

wird die Regionalkarte mit passend ausgeblendeten Objekten aus der Windows-Zwischenablage 
übernommen in die neue Landkartenbox. 

So entstand diese Karte mit wenigen Mausklicks: 
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6.14 Punkte-, Linien-, Flächen- Objekte-Layer anlegen und bearbeiten 

Auf der Basis einer vorhandenen Schicht können neue Layer mit Punkten, Linien, Flächen oder beliebi-
gen Objekten erstellt und anschließend bearbeitet werden. Die Bearbeitungsfunktionen (z.B. geographi-
sche Objekte ergänzen, Darstellung modifizieren) sind auch bei den von RegioGraph mitgelieferten 
Punkte-, Linien- und Flächenlayern anwendbar. 

6.14.1 Punktelayer 

Zum Erzeugen eines neuen Punktelayers startet man den Landkarten-Modus und wählt im Karteninhalts-
fenster aus dem Kontextmenü zu einem vorhanden Layer die Option: 

Neuer Layer > Punkte 

Ist der neue Punktelayer aktiv, kann mit dem Menübefehl 

Einfügen > Punkt 

das Werkzeug  zur Definition neuer Punkte aktiviert werden. Klickt man mit diesem Werkzeug auf 
die gewünschte Position eines neuen Punktes, wird seine Kennung erfragt: 

 
RegioGraph zeigt in der Statuszeile die geographischen Koordinaten des Mauszeigers an, so dass sich mit 
etwas Geduld eine bekannte Position in der Karte ansteuern lässt, um dort einen Punkt zu setzen. Die ge-
wünschte Koordinatendarstellung lässt sich über 

Extras > Optionen > Einheiten 

einstellen, z.B.: 
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Über das Item Eigenschaften im Kontextmenü zu einem vorhandenen Punkt erreicht man die folgende 
Dialogbox, die eine numerische Positionsbestimmung in Dezimalgraden erlaubt: 

 

Über 

Datei > Import > Neue Objekte in folgendem Layer erzeugen 

kann man anlog zum Datenimport (vgl. Abschnitt 5.1) beliebig viele Punkte aus einer Datei importieren 
(Geokodieren). Bei der Lokalisation der neuen Objekte sind zwei Verfahren möglich: 

 Die neuen Punkte werden über ein Abgleichkriterium den Objekten eines vorhandenen Abgleichs-
layers zugeordnet. So lassen sich z.B. Punkte in Gebiete importieren, wobei RegioGraph eine Zu-
fallsverteilung vornimmt. 

 Import von Punkten über ihre geographischen Koordinaten (WGS 84, dezimale Schreibweise) impor-
tiert. 

RegioGraph Planung unterstützt auch den Import über Adressen (Straße mit Hausnummer, PLZ, Ort). ), 
so dass sich z.B. Geomarketing-Präsentationen und -Auswertungen mit der Kundendatenbank eines Un-
ternehmens schnell realisieren lassen. Im folgenden Schritt aus der Import-Assistenten-Dialogboxsequenz 
werden Punkte über drei Importspalten festgelegt: 
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Aus dem Startdialog von RegioGraph lässt sich der Import von Punkten über die Option Kunden oder 
Standorte abbilden starten, wobei ein neues Projekt entsteht. 

Die Objekte eines aktiven Punktelayers lassen sich … 

 bei gedrückter Strg-Taste mit dem Standardwerkzeug  per Maus beliebig verschieben 
Dabei wandert die Beschriftung mit. Durch geeignete Positionierung des Mauszeigers vor dem Klick 
ist es auch möglich, ausschließlich die Beschriftung zu bewegen. RegioGraph zeigt über die Form 
des Mauszeigers an, was verschoben wird, z.B.: 

 
 im markierten Zustand löschen 

 mit einem alternativen Symbol verbinden 
Für alle oder die markierten Punkte kann nach Format > Symbol in folgendem Dialog ein Symbol 
gewählt werden (vgl. Abschnitt 4.3 zur Palette mit Symbolen): 

 
 

6.14.2 Linienlayer 

Zum Erzeugen eines neuen Linienlayers startet man den Landkarten-Modus und wählt im Karteninhalts-
fenster aus dem Kontextmenü zu einem vorhanden Layer die Option: 

Neuer Layer > Linie 

Ist der neue Linienlayer aktiv, kann man mit dem Menübefehl 

Einfügen > Linien 
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das Werkzeug  zur Definition neuer Linien aktivieren und dann durch einfache Mausklicks den Start 
und die Zwischenstationen sowie durch einen Doppelklick den Endpunkt festlegen. Sobald der Schluss-
punkt gesetzt ist, wird die Kennung der neuen Strecke abgefragt, z.B.: 

 

Durch Linien können nicht nur geographische Objekte wie Straßen oder Eisenbahnverbindungen auf ei-
ner Karte repräsentiert werden, sondern z.B. auch Besucherströme. Zugehörige Daten lassen sich dann 
z.B. durch Typ, Farbe oder Stärke der Linien visualisieren. 

Über 

Datei > Import > Neue Objekte in folgendem Layer erzeugen 

kann man anlog zum Datenimport (vgl. Abschnitt 5.1) beliebig viele Linien aus einer Datei mit geogra-
phischen Koordinaten (WGS 84, dezimale Schreibweise) oder mit den Kennungen eines Abgleichs-
Layers in eine (vorhandene oder neue) Linienschicht importieren (Geokodieren). 

RegioGraph Planung unterstützt auch den Import über Adressen (Straße mit Hausnummer, PLZ, Ort). Im 
folgenden Schritt aus der Import-Assistenten-Dialogboxsequenz werden Start- und Zielpunkt eines Li-
niensegments über sechs Importspalten festgelegt: 

 

Gehen Sie folgendermaßen vor, um einen Streckenverlauf auf einem Linienlayer nachträglich zu ändern: 

 Aktivieren Sie den Landkarten-Modus. 
 Legen Sie den Arbeitslayer passend fest. 
 Aktivieren Sie das Standardwerkzeug . 
 Markieren Sie die zu verändernde Strecke. 
 Bei gedrückter Taste S können Sie einzelne Punkte der Polygonlinie anpacken und verschieben. 
 Bei gedrückter Taste A können Sie per Mausklick auf den Linienverlauf neue Punkte einfügen. 
 Bei gedrückter Taste D können Sie per Mausklick überflüssige Punkte löschen. 

Man kann eine Linie … 
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 im markierten Zustand bei gedrückter Strg-Taste mit dem Standardwerkzeug  per Maus verschie-
ben 
Dabei wandert die Beschriftung per Voreinstellung mit. 

 variabel beschriften 
Bei einer unmarkierten Linie lässt sich die Beschriftung separat bewegen, z.B.: 

 
Über den in Abschnitt 6.7 beschriebenen Dialog mit Beschriftungseinstellungen 

 
lässt sich eine am Linienverlauf orientierte Beschriftung anordnen, z.B.: 

 

 im markierten Zustand löschen 

 mit einem alternativen Linientyp verbinden 
Für alle oder die markierten Linien kann nach Format > Linie in folgendem Dialog ein Linientyp 
gewählt und gestaltet werden: 

 
 

6.14.3 Flächenlayer 

Zum Erzeugen eines neuen Flächenlayers startet man den Landkarten-Modus und wählt im Karteninhalts-
fenster aus dem Kontextmenü zu einem vorhanden Layer die Option: 

Neuer Layer > Flächen 

Ist der neue Flächenlayer aktiv, kann man mit dem Menübefehl 

Einfügen > Polygon 

das Werkzeug  zur Definition von neuen Polygonen (Flächen) aktivieren und dann durch Mausklicks 
ein Polygon mit beliebig vielen Zwischenpunkten festlegen. Statt einzelne Punkte anzuklicken, kann man 
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auch mit festgehaltener Maustaste einen Grenzverlauf freihändig zeichnen. Nach dem Schließen des Po-
lygons per Doppelklick wird die Kennung der neuen Fläche abgefragt, z.B.: 

 

Analog zum Vorgehen bei Linien (siehe Abschnitt 6.14.2) kann man auch Flächen nachträglich modifi-
zieren, verschieben oder löschen. 

Hinsichtlich der RegioGraph-Optionen zur kartographischen Darstellung von Daten (siehe unten) gibt es 
keine Unterschiede zwischen Gebieten und Flächen. 
 

6.14.4 Gebietslayer 

In RegioGraph Planung kann man dank des enthaltenen Karteneditors auch neue Gebietsschichten erzeu-
gen. Dazu startet man den Landkarten-Modus und wählt im Karteninhaltsfenster aus dem Kontextmenü 
zu einem vorhanden Layer die Option: 

Neuer Layer > Gebiete 

Anschließend startet man den Karteneditor mit dem Menübefehl 

Karteneditor > Editor starten 

Nun lässt sich mit dem Menübefehl 

Einfügen > Polygon 

das Werkzeug  zur Definition von neuen Polygonen (Gebieten) aktivieren. 

Wie man durch das Digitalisieren einer Rastergrafik (Bitmap-Datei) eine neue Gebietsschicht erzeugt, 
wird in Abschnitt 10.1 beschrieben. 
 

6.14.5 Objektelayer 

Wenn freie Objekte wie Pfeile, Anmerkungen etc. einen Bezug zu Landkartenobjekten haben, sollten sie 
nicht im Layout-Modus eingetragen werden, weil dann der Bezug durch Verschieben oder Zoomen der 
Karte verloren geht. In einem solchen Fall erzeugt man besser einen Objektelayer zur Karte und trägt die 
freien Objekte dort ein. 

Zum Erzeugen eines neuen Objektelayers startet man den Landkarten-Modus und wählt im Karteninhalts-
fenster aus dem Kontextmenü zu einem vorhanden Layer die Option: 

Neuer Layer > beliebige Objekte 

Ist dieser Layer aktiv, stehen die selben Gestaltungsmöglichkeiten wie im Layout-Modus zur Verfügung 
(z.B. Einfügen von Grafikobjekten, siehe Abschnitt 4.3). 

Im folgenden Beispiel wird ein Objektelayer dazu verwendet, um einen Pfeil von der Bezeichnung SK 
Trier bis zum zugehörigen Gebiet zu zeichnen: 
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Denselben Effekt hätte man allerdings (nach dem Markieren des betroffenen Gebiets) auch über den in 
Abschnitt 6.7 beschriebenen Dialog mit Beschriftungseinstellungen erzielen können: 

 

Außerdem hat das Beispiel auf einem zweiten Objektelayer über den Menübefehl 

Einfügen > Grafik aus Datei 

eine Bitmap-Grafik als Hintergrund erhalten. Über den gewünschten Bereich hinausregende Teile der 
Grafik wurden durch individuell deckend weiß gefärbte Gebiete (vgl. Abschnitt 7.1) aus geeigneten 
Schichten (Staaten Europa 2008 bzw. Stadt- und Landkreise Deutschland 2009) abgedeckt. 
 

6.15 Legende mit Layer-Beschreibung 

Nach dem Menübefehl 

Landkarte > Objektlegende einfügen 

hat man die Möglichkeit, in der folgenden Dialogbox eine Legende zur Beschreibung der in einer Karte 
enthaltenen Schichten zu gestalten: 
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Im Beispiel resultiert das Ergebnis: 

 
 

6.16 Projekt- und Karten-bezogene Änderungen an einer Schicht 

Auf einem Flächen-, Punkte- oder Linienlayer kann man Objekte der jeweiligen Kategorie … 

 hinzufügen 
 modifizieren (bei Linien und Flächen) 
 verschieben 
 löschen 

Dies ist auch bei den von RegioGraph gelieferten Schichten möglich. In Abschnitt 6.14 wurden die je-
weils erforderlichen Verfahren vorgestellt. 

Bei einem Gebietslayer erlauben die bisher vorgestellten Verfahren lediglich das Ausblenden und Lö-
schen von Objekten. Mit Hilfe des in RegioGraph Planung enthaltenen Editors gelingt aber auch das Hin-
zufügen und Verändern von Gebieten (siehe Abschnitt 10.2). 

Werden bei einem Layer nach der Übernahme aus der Kartenbibliothek in ein Projekt geographische Ko-
ordinaten geändert (durch Hinzufügen, Löschen, Verschieben oder Modifizieren von Objekten), sind alle 
Karten des Projekts betroffen, die den Layer verwenden. Auch Änderungen bei einer Layertabelle (siehe 
Abschnitt 5) haben Projekt-globale Effekte. Demgegenüber bleiben die folgenden Layer-Modifikationen 
auf eine einzelne Karte beschränkt: 

 Ein-/ausblenden von Objekten 
 Positionen und sonstige Attribute von Beschriftungen 
 Änderungen beim Erscheinungsbild von Objekten (z.B. Linientyp von Strecken oder Flächenbe-

grenzungen) 

Ausschnittsdefinition, geographische Orientierungshilfen (Maßstabsbalken etc.), Perspektive und Projek-
tion beziehen sich nicht auf eine Schicht, sondern auf eine Karte, so dass keine Effekte auf andere Karten 
des Projekts auftreten. 
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6.17 Standardeinstellungen für Schichten 

Wird ein Layer mit einer bestimmten Attributkonfiguration in einem Projekt häufiger benötigt, sollte die-
se Konfiguration zum (Projekt-internen) Standard für den Layer erklärt werden. Im Bundesländerprojekt 
bietet sich dieses Vorgehen für eine Gebietsschicht an, die aus der Vorlage Bundesländer Deutsch-
land 2009 folgendermaßen entsteht: 

 Alle alten Bundesländer ausblenden und die neuen Bundesländer in das Kartenformat einpassen 
 Alle Grenzlinien in schwarzer Farbe mit der Strichstärke 1 mm 
 Beschriftungen mit bestimmter Schriftart und -größe 
 Feste individuelle Farben für alle neuen Bundesländer 

Einen entsprechend gestalteten Arbeitslayer kann man mit dem Menübefehl: 

Landkarte > Als Standard übernehmen 

als Standard (mit Gültigkeit für das Projekt) festlegen. Es erscheint folgender Dialog zur Auswahl der 
Attribute, die in den Standard einfließen sollen: 

 
Wird diese Schicht später aus der Projektverwaltung in eine Karte eingefügt, dann haben alle Attribute 
sofort den gewünschten Wert. Es bietet sich an, die beim Import der Schicht aus der Kartenbibliothek 
übernommene Bezeichnung (z. B. Bundesländer Deutschland 2009) nach dem Setzen neuer Stan-
dardwerte zu verändern. Selbstverständlich kann ein Projekt verwandte Schichten enthalten, die sich 
durch verschiedene Standardattribute unterscheiden. 

Nach der verunglückten Gestaltung einer Kartenschicht kann man mit dem folgenden Befehl zur (Projekt-
internen) Standardkonfiguration zurückkehren: 

Landkarte > Standardeinstellungen laden 

Soll ein modifizierter Layer auch in anderen Projekten Verwendung finden, speichert man ihn in eine 
Datei. Dazu öffnet man in der Projektverwaltung oder im Karteninhaltsfenster das Kontextmenü des Lay-
ers und wählt die Option in der Kartenbibliothek speichern. In der folgenden Dialogbox ist ein 
Layername (für die Anzeige in der Kartenbibliothek) und ein Dateiname (mit dem kompletten Pfad 
und der Namenserweiterung .lay) anzugeben, z.B.: 
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Um den Layer später in ein anderes Projekt übernehmen zu können, muss das Kartenbibliotheksverzeich-
nis passend eingestellt werden (siehe Abschnitt 3.3). 

Wird eine Schicht via Projektverwaltung in der Kartenbibliothek gespeichert, landen dort die Projekt-
bezogenen Standardeinstellungen des Layers. Über das Layer-Kontextmenü im Karteninhaltsfenster spei-
chert man den Layer hingegen mit seinen individuellen Attributen in der aktuellen Karte. 
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7 Individuell formatierte und transparente Schichten 

7.1 Individuelle Gestaltung von Landkartenschichten 

Nun machen wir uns endlich daran, geographische Objekte von Landkartenschichten optisch zu gestalten, 
wobei wir aber noch nicht auf die Merkmale (Spalten) in den Layertabellen zurückgreifen, sondern die 
Attribute einzelner Objekte direkt manipulieren. Zwei Voraussetzungen für dieses Unterfangen dürften 
Ihnen mittlerweile vertraut sein: 

 Der Landkarten-Modus ist aktiv. 
Setzen Sie nötigenfalls einen Doppelklick auf die zu gestaltende Karte. 

 Im Karteninhaltsfenster ist der Arbeitslayer passend gewählt. 

In dieser Situation lassen sich (abhängig vom Typ des Arbeitslayers) über das Format-Menü oder ein 
Steuerelement1 

 
auf der Symbolleiste Formatieren zahlreiche Attribute von markierten geographischen Objekten än-
dern, z.B.: 

  Füllung von Gebieten und Flächen 

  Linientyp von Strecken sowie von Gebiets- oder Flächenbegrenzungen 

  Symbol für die Objekte einer Punkteschicht 

Wie es z.B. bei der Bundesländerkarte in der Einleitung zu sehen ist, wird die Farbe von Gebieten häufig 
zur Datenvisualisierung verwendet, wobei der datenabhängige Farbton eines Gebiets mit einer individuell 
vergebenen Farbe konkurriert. RegioGraph sorgt jedoch dafür, dass die individuelle Gestaltung einer Kar-
tenschicht mit der Datenvisualisierung koexistieren kann. Das Programm kennt im Landkarten-Modus 
eine spezielle Darstellungsart zur Anzeige und Gestaltung individueller Attribute, die über den Menü-
befehl: 

Analysen > Individuelle Formatierung 

oder das Steuerelement1  auf der Symbolleiste Formatieren aktiviert wird. Anschließend wird eine 
Karte unter Verwendung der individuellen Attribute (Farben, Linientypen etc.) neu gezeichnet. 

Ändert man bei angezeigter Datenvisualisierung per Formatieren-Dialog ein in Konkurrenz stehendes 
individuelles Attribut (z.B. die Farbe eines Gebiets), dann wird im folgenden Dialog über die Situation 
informiert und ein Wechsel zur individuellen Formatierung angeboten: 

 

                                                 
1 Per Mausklick auf das kleine Dreieck erscheint ein Menü mit den diversen (größtenteils datenabhängigen) Darstellungsar-

ten. Die zuletzt benutzte Option ist anschließend im Steuerelement direkt anwählbar. 
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Manche Attribute von geographischen Objekten kollidieren nicht mit einer datenabhängigen Visualisie-
rung und bleiben daher bei allen Darstellungsarten in Kraft (z.B. der Linientyp von Gebietsbegrenzun-
gen). 
 

7.2 Transparente Gebiets- oder Flächenschichten 

Wenn eine Gebiets- oder Flächenschicht über anderen Schichten liegt, kann es sinnvoll sein, sie transpa-
rent darzustellen. Dann werden nur die Umrisse gezeichnet, aber keine Füllungen, so dass die darunter 
liegenden Schichten sichtbar bleiben. Diese Darstellungsart ist in RegioGraph nach dem Einfügen einer 
Gebiets- oder Flächenschicht voreingestellt und kann im Landkarten-Modus mit dem Steuerelement1  
auf der Symbolleiste Formatieren oder dem Menübefehl 

Analysen > Transparente Darstellung 

für den Arbeitslayer eingestellt werden. 
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8 Kartographische Visualisierung von Daten 
In diesem Abschnitt sollen endlich die von RegioGraph gebotenen Methoden zur kartographischen Vi-
sualisierung von Daten behandelt werden, wobei die gemäß Abschnitt 5.1 importierten Daten Verwen-
dung finden. Diese Methoden setzen einen aktiven Landkarten-Modus und einen passend gewählten Ar-
beitslayer voraus. 

Werden für eine Schicht auf einer Karte nacheinander mehrere Visualisierungen definiert, kann natürlich 
nur die aktuelle angezeigt werden. Jedoch werden die anderen Spezifikationen nicht verworfen, sondern 
in der Projektdatei zur späteren Wiederverwendung gespeichert. 

Sollen mehrere (kompatible) Visualisierungen (z.B. Gebietseinfärbung und Diagramme) simultan sicht-
bar sein, stapelt man entsprechend konfigurierte Schichten. 
 

8.1 Ausprägungen eines Merkmals mit beliebigem Messniveau 

Hierbei handelt es sich um eine univariate Darstellungstechnik für Layer von beliebigem Typ (außer Ob-
jekt), wobei für alle geographischen Objekte ihre Ausprägung bei einer numerischen oder textuellen Va-
riablen angezeigt wird. Im Unterschied zu vielen anderen Darstellungsmöglichkeiten werden die Vari-
ablenausprägungen nicht in Klassen eingeteilt. Damit eignet sich diese Darstellungsart z.B. für: 

 kategoriale Merkmale mit relativ wenigen Ausprägungen, für die jeweils eine individuelle Darstel-
lung festgelegt wird, 

 metrische Merkmale mit beliebig vielen Ausprägungen, wobei anstelle einer Individualkonfiguration 
ein Farbverlauf definiert wird. 

Mit dem Menübefehl 

Analysen > Merkmale 

oder dem Steuerelement1  auf der Symbolleiste Formatieren wird folgende Dialogbox angefordert: 

 
Auf dem Registerblatt Daten ist die darzustellende Variable aus der Tabelle zum Arbeitslayer zu wählen. 
Wir entscheiden uns für die kategoriale Variable LANDREG12_05 mit den deutschen Landesregierungen 
im Mai 2012, die sich seit dem in Abschnitt 5.1 beschriebenen Datenimport in der Bundesländertabelle 
befindet und für eine Momentaufnahme der politischen Landschaft in Deutschland geeignet ist. 

Zur Darstellung eines metrischen Merkmals kann es sinnvoll sein, mit dem Schalter  der Dialogbox 
Merkmale einen Farbverlauf zu definieren, z.B.: 
                                                 
1 Per Mausklick auf das kleine Dreieck erscheint ein Menü mit den in Abschnitt 8 beschriebenen Darstellungsoptionen. Die 

zuletzt beim aktuellen Arbeitslayer benutzte Option ist anschließend im Steuerelement direkt anwählbar. 
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Diese Technik wurde bei dem in der Einleitung präsentieren Arbeitsblatt zur Verkehrssicherheit in den 
Bundesländern verwendet. Im Unterschied zum Ausprägungs-internen Farbverlauf, den wir gleich ver-
wenden werden, geht es hier um einen Verlauf über alle Ausprägungen hinweg, wobei jedes einzelne 
Objekt homogen gefärbt wird. 

Wenn (wie im Beispiel mit der politischen Momentaufnahme) eine kategoriale Variable dargestellt wird 
(ohne ordinale oder gar metrische Struktur), ist für jede Ausprägung eine individuelle Darstellungsform 
zu wählen. Die nach dem Mausklick auf die Stilzelle zu einer Ausprägung verfügbaren Darstellungsopti-
onen hängen vom Layertyp ab: 

 Bei einem Gebiets- oder Flächenlayer bietet die Dialogbox Füllung ihre zahlreichen Optionen an. 
Im Beispiel sollen Koalitionsregierungen durch Farbverläufe dargestellt werden, z.B. bei einer 
SPD/CDU - Koalition: 

 

Für Dreierkoalitionen ist ein Von/Bis – Farbverlauf aber ungeeignet. Im aktuellen Fall der Dänenam-
pel in Schleswig-Holstein (SPD, Grüne SSW) wird als Notlösung das SSW-Emblem (Südschleswiger 
Wählerverband) auf die Rot/Grüne Grundfläche montiert, wobei ein Objektelayer zum Einsatz 
kommt: 

 
Um die ehemalige Jamaika-Koalition im Saarland (CDU, FDP und Grüne) darzustellen, könnte man 
eine Bitmap-Grafik mit der Jamaika-Flagge auf der Fläche des Saarlands anzeigen, was so zu be-
werkstelligen wäre: 
- in der Dialogbox Merkmale die Jamaika-Farbzelle transparent definieren, 
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- die Jamaika-Flagge auf einen Objektelayer montieren, 
- eine Gebietsschicht mit den Ländern Europas zum Abdecken überragender Flaggenteile verwen-

den. 

   

 Bei einem Punktelayer erscheint die Dialogbox Symbol und bei einem Linienlayer die Dialogbox 
Linie: 

  

Bei einem Punktelayer kann man auf der Registerkarte Daten der Merkmale-Dialogbox mit dem Schal-
ter Gleiche Symbole das Symbol der ersten Variablenausprägung (hinsichtlich Form, Farbe und Grö-
ße) als Vorgabe für alle anderen übernehmen. Analog wird bei einem Linienlayer mit dem Schalter Glei-
che Linien der Linientyp der ersten Variablenausprägung auf alle anderen übertragen. 

Die Registerkarte Legende 

 
der Merkmale-Dialogbox bietet folgende Möglichkeiten: 
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 Legende ein bzw. abschalten 

 Titel und Untertitel selbst formulieren oder Standardtexte verwenden 

 Schriftart für Titel, Untertitel und Legendentexte (zu den Ausprägungen) festlegen 

 Statt in einer Legendenspalte alle Kategorien untereinander zu listen, sind bei einer hohen Anzahl 
von Kategorien mehrere Spalten sinnvoller. 

Für die politische Landschaft im Mai 2012 resultiert folgendes Bild: 

 

Im Layout-Modus kann man die Legende zu einer Merkmalsdarstellung optisch modifizieren, z.B. Hin-
tergrundfarbe, Transparenz, Rahmentyp, Größe und Position ändern. Trotzdem wirken sich die anschlie-
ßend im Landkarten-Modus durch erneute Verwendung des Merkmale-Dialogs vorgenommenen Ände-
rungen der Darstellung (z.B. Füllstile der Merkmalsausprägungen, Legendentexte) weiterhin auf die indi-
viduell gestaltete Legende aus. 

Nach dem Trennen der Legende (via Kontextmenü im Layout-Modus) sind alle Bestandteile (z.B. auch 
die Beschriftungen der Merkmalsausprägungen) beliebig änderbar. Allerdings entsteht so ein fixiertes 
Layout-Element, das nicht mehr reagiert, wenn im Landkarten-Modus per Merkmale-Dialog die Darstel-
lung geändert wird. 

Im Beispiel ist die vom Merkmale-Dialog erstellte Legende getrennt und dann modifiziert worden: 
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 Gruppierung der Objekte aufheben 
 Legendeneintrag für SPD/Grüne löschen 
 Legendeneintrag für SPD/Grüne/SSW umgestalten 
 Objekte neu ausrichten und wieder gruppieren 

 

8.2 Piktogrammdarstellung 

Bei der Piktogrammdarstellung heftet man den geographischen Objekten einer Schicht mit beliebigem 
Typ (außer Objekt) datenabhängig Symbole (Piktogramme) an, wobei jedes Symbol eine dichotome Va-
riable darstellt: Das Symbol erscheint bei einem geographischen Objekt genau dann, wenn dieses Objekt 
bei der zugehörigen Variablen einen von Null (numerischer Typ) bzw. von der leeren Zeichenfolge 
(Textvariablen) verschiedenen Wert hat. 

Im folgenden (nicht sehr ernst gemeinten) Beispiel wird untersucht, ob Bundesländer ohne Bindestrich im 
Namen tendenziell eine überdurchschnittliche Pro-Kopf – Kaufkraft besitzen.1 Zu diesem Zweck wurden 
zwei Variablen in die Bundesländer-Gebietstabelle aufgenommen, die bei vorhandenem Merkmal 
(Bindestrich im Namen, Pro-Kopf - Kaufkraftindex 2009 > 105) den Wert Eins annehmen und ansonsten 
eine Null: 

 

Mit dem Menübefehl 

Analysen > Piktogramme 

oder dem Steuerelement2  wird folgende Dialogbox angefordert: 

  
Auf dem Registerblatt Daten … 

                                                 
1 Angeregt wurde diese Untersuchung durch die Interviewaussage eines ehemaligen deutschen Ministerpräsidenten (im Mai 

2008), seine Landeskinder könnten froh darüber ein, nicht in „irgendeinem Bindestrichland“ zu leben. 
2 Per Mausklick auf das kleine Dreieck erscheint ein Menü mit den in Abschnitt 8 beschriebenen Darstellungsoptionen. Die 

zuletzt beim aktuellen Arbeitslayer benutzte Option ist im Steuerelement direkt anwählbar. 
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 legt man zunächst mit dem Listen-Steuerelement (unten links) die Anzahl der dargestellten dichoto-

men Merkmale fest (im Beispiel: 2) 

 wählt man die Variablen, für die jeweils ein Piktogramm einen von Null verschiedenen Wert bei ei-
nem geographischen Objekt signalisieren soll 

 wählt man für jedes Merkmal ein Piktogramm nach einem Klick auf seine Symbolzelle, z.B.: 

 
Das Bindestrichsymbol wurde über eine mit der Windows-Beigabe Paint erstellte Bitmap-Datei im 
PNG-Format (Portable Network Graphics) in die Symbolauswahl aufgenommen (vgl. Abschnitt 4.3). 

 kann man die Layerobjekte ausblenden 
Im Beispiel würden die Umrisse der Gebiete verschwinden. 

 wird man nur selten gleiche Symbole für alle Merkmale wählen. 

 entscheidet man sich zwischen einer individuellen oder einheitlichen Größe der Symbole 

Auf dem Registerblatt Legende wird im Beispiel veranlasst, dass für jedes Piktogramm die Anzahl der 
betroffenen Objekte angezeigt werden soll: 

 

Auf dem anschließend abgebildeten Arbeitsblatt wurde die Legende abgetrennt (vgl. Abschnitt 8.1), um 
die Symbole vergrößern zu können: 

Originallegende Modifizierte Legende 

  

Das Ergebnis: 
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Bis auf die Ausnahme Baden-Württemberg sind tatsächlich in den Bindestrichländern keine Einkaufswa-
gen (als Symbol für hohe Kaufkraft) anzutreffen. 

Um die Hintergrundfarbe zu realisieren, wurde unter die Schicht mit den Piktogrammen ein weiteres Ex-
emplar der Gebietsschicht mit den deutschen Bundesländern gelegt 

 
und über die Individuelle Formatierung  durchgehend grün eingefärbt. 
 

8.3 Klassen einer numerischen Variablen durch Füllstile oder Linientypen darstellen 

Bei dieser für Gebiets-, Flächen- und Linienlayer verfügbaren Darstellungsart wird eine numerische Va-
riable (Datentyp Ganzzahl oder Dezimal) erwartet und in Klassen unterteilt. Im folgenden Beispiel aus 
dem Bundesländerprojekt geschieht dies mit der importierten Variablen UNFREL3, welche die 2006 be-
obachtete Anzahl von Verkehrstoten pro 1 Million Einwohner enthält:1 

                                                 
1 Eine Variante dieses Arbeitsblatts mit einer Merkmals-Darstellung (vgl. Abschnitt 8.1) von 16 individuellen Werten war 

schon in der Einleitung zu sehen. 
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Das Visualisieren von Klassen per Füllung oder Linientyp wird mit dem Menübefehl 

Analysen > Flächen und Linien nach Klassen 

bzw. mit dem Steuerelement1  angefordert und in folgender Dialogbox spezifiziert: 

 

                                                 
1 Per Mausklick auf das kleine Dreieck erscheint ein Menü mit den in Abschnitt 8 beschriebenen Darstellungsoptionen. Die 

zuletzt beim aktuellen Arbeitslayer benutzte Option ist anschließend im Steuerelement direkt anwählbar. 
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Auf dem Registerblatt Daten kann für die ausgewählte Datenspalte sehr flexibel eine Klasseneintei-
lung definiert werden: 

 Über das Aufklappmenü Werteverteilung (Symbolschalter ) legt man fest, nach welchem Prin-
zip die Kategoriengrenzen festgelegt werden sollen: 

o Gleichverteilt 
RegioGraph bildet gleich stark besetzte Klassen. 

o Gleiche Abstände 
RegioGraph bildet gleich breite Intervalle. Diese Variante wird im Beispiel benutzt. 

o Statistisch verteilt 
Am linken bzw. rechten Rand wird jeweils eine Klasse mit den Fällen jenseits der Grenze von 
zwei Standardabweichungen unter bzw. über dem arithmetischen Mittelwert gebildet. Dazwi-
schen werden gleich breite Intervalle gebildet mit dem arithmetischen Mittel im mittleren Inter-
vall. 

o Natürliche Grenzen 
RegioGraph versucht, die Klassengrenzen zwischen Häufungszonen in der empirischen Vertei-
lung zu setzen. 

o Logarithmische Abstände 
RegioGraph bildet gleich breite Intervalle bzgl. der logarithmierten Daten. Dies führt zu einem 

konstanten Quotienten 
i

i

x

x 1  für aufeinander folgende Intervallgrenzen xi, z.B. x1 = 1, x2 = 10, x3 = 

100 usw. 

 Man kann die Anzahl der Klassen wählen. 

 Über die Auswahlliste zur Klassenabgrenzung legt man fest, wie über die Zugehörigkeit eines Ob-
jekts zu einem Intervall am linken (> oder ) und am rechten Rand (< oder ) entschieden wird. 

 Die automatisch gebildeten Klassengrenzen können durch individuelle Werte überschrieben werden. 
Man eröffnet das Editieren eines Werts per Doppelklick auf die betroffene Zelle. 

 Die Klassengrenzen lassen sich in einer Datei (mit Namenserweiterung .cla) speichern ( ) bzw. von 
dort laden ( ). 

Das Daten-Registerblatt zeigt für jede Klasse die momentan gültige Darstellungsform. Nach einem Klick 
auf die entsprechende Zelle kann eine alternative Darstellung gewählt werden, wobei die Auswahl vom 
Layertyp abhängt. Statt eine individuelle Farben festzulegen, kann man über Schalter  einen Farbver-
lauf definieren. 

Das Registerblatt Verteilung unterstützt die Klassendefinition: 

 Für jeden aufgetretenen Wert zeigt ein schmaler Balken seine Häufigkeit. 
 Die Intervalle sind durch ihren aktuell gewählten Füllstil unterscheidbar gemacht. 

Im Beispiel haben alle Balken die Höhe Eins, weil kein Wert mehrfach auftritt: 
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Die Registerkarte Legende 

 
bietet folgende Möglichkeiten: 

 Legende ein bzw. ausschalten 

 Standardtexte (ab)wählen 

 Nach dem Ausschalten der Standardtexte lassen sich Titel, Untertitel und Intervallbeschreibungen 
individuell formulieren. 

 Bei der individuellen Intervallbeschreibung wird das Editieren eines Eintrags per Doppelklick eröff-
net. Mit dem Doppelkreuz (#) sorgt man für ausgerichtete Spalten. 

 Schriftarten für Titel, Untertitel und Intervallbeschreibungen festlegen 

 Anzahl der Objekte in den Klassen einblenden 

 Statt in einer Legendenspalte alle Klassen untereinander aufzulisten, sollte man bei einer großen An-
zahl von Klassen die Spaltenzahl erhöhen. 

 

8.4 Klassen einer numerischen Variablen durch Symbole darstellen 

Intervalle einer numerischen Variablen (Datentyp Ganzzahl oder Dezimal) können bei Schichten mit be-
liebigem Typ (außer Objekt) durch unterschiedliche Symbole dargestellt werden. Als Anwendungsbei-
spiel betrachten wir eine Darstellung der Sterberaten in den deutschen Bundesländern durch Grabkreuze 
passender Größe: 
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Die Darstellung von Klassen einer numerischen Variablen durch Symbole wird mit dem Menübefehl 

Analysen > Symbole nach Klassen 

oder mit dem Steuerelement1  angefordert und in folgender Dialogbox spezifiziert: 

 

                                                 
1 Per Mausklick auf das kleine Dreieck erscheint ein Menü mit den in Abschnitt 8 beschriebenen Darstellungsoptionen. Die 

zuletzt beim aktuellen Arbeitslayer benutzte Option ist anschließend im Steuerelement direkt anwählbar. 
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Auf dem Registerblatt Daten stehen die schon in Abschnitt 8.3 besprochenen Optionen zur Auswahl 
einer Variablen und einer Klasseneinteilung zur Verfügung. Das Beispiel verwendet die gem. Abschnitt 
5.1.2 importierte Variable STERBREL (Sterbefälle pro 1 Million Einwohner 2005) und fünf Klassen mit 
gleicher Breite. 

Über den Schalter Gleiche Symbole kann man das Symbol der ersten Klasse hinsichtlich Form, Farbe 
und Größe als Vorgabe für alle anderen übernehmen. Wenn man die Variablenausprägungen nicht (nur) 
durch Gestalt und Farbe der Symbole, sondern auch durch deren Größe zum Ausdruck bringen möchte, 
ist die individuelle Größe zu wählen. 

Für jede Klasse kann durch Anklicken ihrer Stilzelle die folgende Dialogbox geöffnet werden, um ein 
Symbol samt Farbe und Größe festzulegen, z.B.: 

 
Es verwundert, dass RegioGraph an dieser Stelle eine manuelle Größenangabe verlangt, statt passende 
Werte aus den Daten zu berechnen. Immerhin ermöglicht diese etwas umständliche Methode eine unein-
geschränkte Flexibilität beim Festlegen der Symbolgrößen zu den einzelnen Klassen. Eine Symboldar-
stellung mit automatischer Größenberechnung ermöglicht RegioGraph über Mehrdimensionale Sym-
bole (siehe Abschnitt 8.5) und über den speziellen Diagrammtyp Skalierte Symbole (siehe Abschnitt 
8.10). 

Um eine hohe Varianz der Symbolgrößen zu erreichen, werden im Beispiel die mittleren Beobachtungs-
werte in den Klassen kx  (k = 1, .., 5) folgendermaßen transformiert: 

507
1000

 k
k

x
x  

So resultieren darstellungstechnisch günstige Symbolgrößen (in mm): 

Intervall Mittelwert der Fälle 
im Intervall 

Transformierter 
Wert 

 0    9265,18 8630,87 10,42 
 9265,18    - 9899,49 9527,10 16,69 
 9899,49    - 10533,80 10289,16 22,02 
 10533,80    - 11168,12 10922,32 26,46 
 11168,12   <  11598,90 31,19 

Um objektiv zu informieren und jeden Täuschungsverdacht zu vermeiden, werden neben den Symbolen 
auch die tatsächlichen Sterberaten der Bundesländer auf der Karte angezeigt (siehe unten). 

Das im aktuellen Beispiel verwendete Symbol wurde mit einem Vektor-Grafikprogramm erstellt und im 
WMF-Format (Windows Meta File) abgespeichert. Wie man eigene Symbole in die RegioGraph-Palette 
aufnehmen und dauerhaft speichern kann, wird in Abschnitt 4.3 beschrieben. 
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Auf dem Registerblättern Verteilung und Legende tauchen gegenüber der Beschreibung in Abschnitt 
8.2 keine Neuerungen auf. 

In der Legende zur aktuell behandelten Darstellungstechnik erscheinen die Symbole der Klassen gleich 
groß, was nur bei Verwendung von unterschiedlichen Formen oder Farben zu einer informativen Anzeige 
führt. Im Beispiel wird daher auf eine Legende verzichtet. 

In der Karte sollen (neben den Symbolen) die Namen der Bundesländer und die Sterberaten erscheinen. 
Realisiert man beide Angaben über die Beschriftung einer Gebietsschicht, werden sie stets zusammen-
hängend angezeigt, was die Gestaltungsfreiheit stark einschränkt. Daher wird im Beispiel eine zusätzliche 
Bundesländer-Gebietsschicht zur Anzeige der Namen aufgenommen. So kann man die Namen der Bun-
desländer, die Sterberaten und die Symbole unabhängig voneinander verschieben (nach passender Wahl 
des Arbeitslayers und bei gedrückter Strg-Taste). Um die Symboldarstellung durch eine korrespondie-
rende Einfärbung der Gebiete zu unterstützen, wird in der unteren Gebietsschicht eine Darstellung der 
Sterberaten durch Grautöne eingerichtet (siehe Abschnitt 8.3). 

 
Darstellung durch Farben, Anzeige der Ländernamen
Darstellung durch Symbole, Anzeige der Sterberaten 

 
 

8.5 Mehrdimensionale Symbole 

Während bei der in Abschnitt 8.4 beschriebenen Darstellung von Klassen nach Symbolen nur eine Vari-
able veranschaulicht wird, können bei der nun vorzustellenden, moderneren und flexibleren Technik über 
die Form, Farbe und Größe von Symbolen bis zu drei verschiedene (metrische oder kategoriale) Dimen-
sionen dargestellt werden. 

Eine Darstellung von ein, zwei oder drei Variablen durch mehrdimensionale Symbole wird mit dem Me-
nübefehl 

Analysen > Mehrdimensionale Symbole 

bzw. mit dem Steuerelement1  angefordert und in der folgenden Dialogbox spezifiziert: 

 

                                                 
1 Per Mausklick auf das kleine Dreieck erscheint ein Menü mit den in Abschnitt 8 beschriebenen Darstellungsoptionen. Die 

zuletzt beim aktuellen Arbeitslayer benutzte Option ist anschließend im Steuerelement direkt anwählbar. 
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Für den Symboltyp, die Symbolfarbe und die Symbolgröße kann jeweils eine Variable gewählt 
werden. Ist die Option Merkmale gewählt, erhält jede Ausprägung eine eigene Darstellung. Über die nur 
bei numerischen Variablen verfügbare Option Werte entscheidet man sich für die Darstellung von Klas-
sen. Über den Schalter Einstellen ist ein Dialog zur Gestaltung der jeweiligen Dimension verfügbar. 

Im Anwendungsbeispiel stellen wir die numerische Bundesländervariable STERBREL durch Kreuze mit 
variabler Farbe und Größe dar, wobei leider die Ausdrucksmöglichkeiten des mehrdimensionalen Dia-
gramms zum großen Teil ungenutzt bleiben: Von den drei Darstellungsdimensionen (Typ, Farbe, Größe) 
werden nur zwei variiert, und die stellen auch noch dieselbe Variable dar. 

Beim Symboltyp entscheiden wir uns für die Option gleiches Symbol verwenden und wählen die-
sen konstanten Typ nach einem Klick auf den Schalter Einstellen aus der folgenden Dialogbox: 

 

Die Symbolauswahl ist erweiterbar und Bestandteil der Palette. In Abschnitt 4.3 wird beschrieben, wie 
man eine (z.B. durch eigene Symbole) individualisierte Palette speichern und bei späteren RegioGraph-
Einsätzen wieder verfügbar machen kann. 

Bei der Symbolfarbe wird für fünf annähernd gleich stark besetzte Klassen ein Verlauf vom römisch-
katholischen Liturgie-Violett bis zum tiefen Schwarz gewählt: 

 
Die Optionen zur Klassendefinition wurden schon in Abschnitt 8.3 erläutert. 

Im Dialog zur Einstellung der Klassen für die Symbolgröße lassen sich die automatisch berechneten 
Größen, die (wenig beeindruckend) nur im schmalen Bereich von 3 bis 5 Millimetern variieren, indivi-
duell ändern, z.B.:1 

                                                 
1 Bei den skalierten Symbolen (siehe Abschnitt 8.10) lassen sich demgegenüber die automatisch berechneten Größen über 

einen Faktor spreizen. 
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Automatisch berechnete Größen Individuell festgelegte Größen 

  

Mit den schon in Abschnitt 8.4 verwendeten Symbolgrößen erhält man die folgende Darstellung: 
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8.6 Punktdichtedarstellung 

Für Häufigkeitsdaten zu Gebieten oder Flächen ist die Punktdichtedarstellung gut geeignet. Als Beispiel 
im Rahmen unseres Bundesländerprojekts drängt sich die Darstellung der Bevölkerungsdichte durch 
Verwendung der gem. Abschnitt 5.1.1 importierten Variablen EINWOHNER auf: 

 

Eine Punktdichtedarstellung wird mit dem Menübefehl 

Analysen > Punktdichte 

bzw. mit dem Steuerelement1  angefordert und in folgender Dialogbox spezifiziert: 

                                                 
1 Per Mausklick auf das kleine Dreieck erscheint ein Menü mit den in Abschnitt 8 beschriebenen Darstellungsoptionen. Die 

zuletzt beim aktuellen Arbeitslayer benutzte Option ist anschließend im Steuerelement direkt anwählbar. 
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Auf der Suche nach einer guten Darstellung kann man auf dem Registerblatt Daten mit dem Wert, der 
Punktgröße und der Punktfarbe experimentieren. Beim gewählten Wert 4000 resultieren z.B. für 
Bayern (mit 12.520.332 Einwohnern im Jahr 2008) 

3130
4000

12520332
  

Punkte, die gleichmäßig auf das Gebiet verteilt werden. 

Wenn Ihnen die obige Karte zu blass erscheint, können Sie eine andere Hintergrundfarbe wählen, z.B.: 

 



 

 92 

Thematische Kartographie mit RegioGraph 11 
 
Allerdings lässt sich die Hintergrundfarbe unter den Pünktchen nicht auf derselben Gebietsschicht reali-
sieren, weil die Individualfarben (vgl. Abschnitt 7.1) nicht gleichzeitig mit der Punktdichte dargestellt 
werden können. Die Lösung des Problems besteht darin, eine zweite Bundesländer-Gebietsschicht mit 
geeigneter Individualfärbung unter die Gebietsschicht mit der Punktdichte zu legen. 

Um die Lesbarkeit der Beschriftungen zu verbessern, wurden sie nach dem Menübefehl 

Format > Schrift 

freigestellt: 

 
 

8.7 Portfolio-Darstellung 

Mit der Portfolio-Darstellung, die bei Gebiets-, Flächen-, und Linienlayern zur Verfügung steht, können 
für die geographischen Merkmalsträger die Ausprägungen von zwei numerischen Variablen simultan über 
Füllstile bzw. Linientypen dargestellt werden. Im Bundesländerbeispiel soll mit dieser Technik unter-
sucht werden, ob in Ländern mit hoher ärztlicher Versorgungsdichte die Sterberate tendenziell niedriger 
ausfällt. Das Streudiagramm für die Regression von STERBREL auf ARZTREL zeigt allerdings erhebli-
che strukturelle Unterschiede zwischen den Stadt- und den Flächenländern, so dass eine gemeinsame 
Analyse nicht sinnvoll erscheint: 

 

Daher werden in der Portfolio-Darstellung nur die Flächenländer berücksichtigt: 
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Die Länder Berlin, Bremen und Hamburg mit ihrer extrem hohen Ärztedichte wurden durch Ausblenden 
der Gebiete ausgeschlossen (vgl. Abschnitt 6.6). Um ihre Flächen neutral gelb erscheinen zu lassen, wur-
de über die Schicht mit der Portfolio-Darstellung eine passend konfigurierte zweite Bundesländer-
Gebietsschicht gelegt: 

 
Hier sind alle Gebiete mit Ausnahme der Länder Berlin, Bremen und Hamburg transparent eingestellt 
(vgl. Abschnitt 7.2). 
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Die Portfolio-Darstellung wird mit dem Menübefehl 

Analysen > Portfolio 

bzw. mit dem Steuerelement1  angefordert und in folgender Dialogbox spezifiziert: 

 
Auf dem Daten-Registerblatt müssen in Bezug auf die X- und die Y-Achse Klassen gebildet werden, 
wobei pro Variable maximal vier Intervalle erlaubt sind. 

Im Beispiel wird zur Darstellung der Ausprägungskombinationen folgendes Schema angewendet: 

 Eine niedrige, mittlere oder hohe Ärztedichte wird durch die Hintergrundfarben Weiß, Blassrosa oder 
Rot ausgedrückt. 

 Um die drei Klassen bzgl. der Sterberate darzustellen, erscheinen keine, schlanke oder kräftige Kreu-
ze, realisiert durch Muster. 

Nach einem Mausklick auf die Portfolio-Matrixzelle einer Ausprägungskombination erscheint die Dia-
logbox Füllung. Um ein vorhandenes Muster auf die aktuelle Zelle anzuwenden, … 

 wechselt man zur Registerkarte Muster, 

 wählt eine Vorder- und eine Hintergrundfarbe, 

 markiert die gewünschte Zelle per Mausklick, so dass ihr Muster in der Vorschau unten rechts er-
scheint, z.B. 

 

                                                 
1 Per Mausklick auf das kleine Dreieck erscheint ein Menü mit den in Abschnitt 8 beschriebenen Darstellungsoptionen. Die 

zuletzt beim aktuellen Arbeitslayer benutzte Option ist anschließend im Steuerelement direkt anwählbar. 
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 und übernimmt die Wahl per OK. 

Um ein eigenes Muster zu kreieren, setzt man einen Rechtsklick auf eine momentan nicht benötigte Vor-
lage und kann daraufhin in der Dialogbox Muster editieren für jeden Pixel per Linksklick zwischen 
Vorder- und Hintergrundfarbe wechseln, wobei eine (8  8) - Pixelmatrix zur Verfügung steht: 

 
RegioGraph speichert diese Änderungen (wie z.B. auch ergänzte Symbole und selbst erstellte Linienstile) 
in der aktuellen Palette, die über 

Format > Palette 

in eine pal-Datei gespeichert und in einer späteren Sitzung von dort geladen werden kann. 

Eine statistische Analyse der Pearson-Korrelation zwischen ARZTREL und STERBREL zeigt übrigens 
keinen signifikanten Zusammenhang (ohne Berlin, Bremen und Hamburg): 

     
Ärzte pro 1000 

Einwohner 

Sterbefälle 
pro 1 Mio 
Einwohner 

Korrelation nach Pearson 1 -,315 
Signifikanz (1-seitig)  ,147 

Ärzte pro 1000 Einwohner 

N 13 13 
Korrelation nach Pearson -,315 1 
Signifikanz (1-seitig) ,147   

Sterbefälle pro 1 Mio Ein-
wohner 

N 13 13 

Bei einer Portfolio-Darstellung für eine Linienschicht ist für jede Matrixzelle ein eigener Linientyp fest-
zulegen. 

Zur simultanen Darstellung von zwei Dimensionen zu Gebieten oder Flächen kann man neben der eben 
beschriebenen Portfolio-Technik auch ein Symbol-Portfolio (siehe Abschnitt 8.8), mehrdimensionale 
Symbole (siehe Abschnitt 8.5) oder eine Mehrschichttechnik verwenden, z.B. 

 mit einer Gebietsbasisschicht zur farblichen Darstellung der ärztlichen Versorgungsdichte (siehe Ab-
schnitt 8.3) 

 und einer darüber liegenden Gebietsschicht mit Symboldarstellung für die Sterberate (siehe Abschnitt 
8.4). 
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Vorteile gegenüber der Portfolio-Darstellung: 

 Es werden variable Ausdrucksmittel verwendet (Füllstile und Symbole). 

 Es sind beliebig viele Klassen möglich (statt einer Beschränkung auf maximal vier pro Dimension). 

 Statt für jede Zelle eine individuelles Erscheinungsbild festzulegen, sind für beide Dimensionen Dar-
stellungen der Klassen zu definieren, was im Allgemeinen weniger Aufwand bedeutet. 

Das zuletzt genannte Argument kann man in statistischen Begriffen so beschreiben, dass man mit einem 
Haupteffektmodell arbeitet. Eventuell soll aber eine Wechselwirkung visualisiert werden, wozu eine indi-
viduelle Gestaltung aller Wertekombinationen (Zellen) nötig ist. 
 

8.8 Symbol-Portfolio 

Die Symbol-Variante der Portfolio-Darstellung eignet sich für alle Layertypen. Ihre Besonderheit gegen-
über dem Standard-Portfolio besteht darin, dass den Matrixzellen Symbole zugewiesen werden, die in 
Form, Farbe und Größe variieren können. 
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Das Symbol-Portfolio wird mit dem Menübefehl 

Analysen > Symbol-Portfolio 

bzw. mit dem Steuerelement1  angefordert und in folgender Dialogbox spezifiziert: 

 

Im Beispiel wird zur Darstellung der Ausprägungskombinationen folgendes Schema angewendet: 

 Alle Zellen erhalten dasselbe Symbol (hinsichtlich der Form). 

 Eine niedrige, mittlere oder hohe Ärztedichte wird durch die die Farbe des Symbols dargestellt. 

 Die drei Klassen bzgl. der Sterberate werden durch die Symbolgrößen dargestellt, berechnet analog 
zum Verfahren in Abschnitt 8.4: 

Intervall Mittelwert kx  der Fälle

im Intervall 

Transformierter Wert 

507
1000

kx
 

 Min - 9000 8630,87 10,42 
 9000 - 10700 9527,10 19,89 
 10700 - Max 10289,16 29,30 

Das Ergebnis: 

                                                 
1 Per Mausklick auf das kleine Dreieck erscheint ein Menü mit den in Abschnitt 8 beschriebenen Darstellungsoptionen. Die 

zuletzt beim aktuellen Arbeitslayer benutzte Option ist anschließend im Steuerelement direkt anwählbar. 
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Oft sind die in Abschnitt 8.5 beschriebenen mehrdimensionalen Symbole als Darstellungstechnik gegen-
über dem Symbol-Portfolio zu bevorzugen, denn: 

 Beim Symbol-Portfolio können nur zwei Dimensionen dargestellt werden, mit mehrdimensionalen 
Symbolen hingegen bis zu drei. 

 Während beim Symbol-Portfolio pro Dimension maximal vier Klassen gebildet werden können, exis-
tiert bei den mehrdimensionalen Symbolen keine Beschränkung der Klassenzahl. 

 Während beim Symbol-Portfolio für jede Zelle ein individuelles Erscheinungsbild festzulegen ist, 
definiert man bei den mehrdimensionalen Symbolen Darstellungen der Klassen für die beteiligten 
Dimensionen, was im Allgemeinen weniger Aufwand bedeutet. 

Das zuletzt genannte Argument kann man in statistischen Begriffen so beschreiben, dass man bei den 
mehrdimensionalen Symbolen mit einem Haupteffektmodell arbeitet. Eventuell soll aber eine Wechsel-
wirkung visualisiert werden, wozu die beim Symbol-Portfolio mögliche individuelle Gestaltung aller 
Wertekombinationen (Zellen) erforderlich ist. 
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8.9 Dreidimensionale Darstellungen 

8.9.1 3D-Gitternetz 

Bei dieser univariaten Darstellungsart für numerische Variablen und beliebige Schichttypen (außer Ob-
jekte) wird ein Gitter über die Landkarte gelegt. Jede Gitterzelle erhält für die darzustellende Variable 
einen Höhenwert, der per 3D-Geländeformation und farblich dargestellt wird. Zum Wert einer Zelle lie-
fern alle in ihrem Bereich liegenden geographischen Objekte (Gebiete, Flächen, Linien oder Punkte) ei-
nen Beitrag, wobei abhängig vom Typ des Layers unterschiedliche Kombinationsmethoden zur Verfü-
gung stehen. Während bei einem Punktelayer in einer einzelnen Zelle durchaus mehrere Objekte zu er-
warten sind, erstrecken sich Gebiete oder Flächen meist über mehrere Zellen. 

Das folgende Arbeitsblatt veranschaulicht die Pro-Kopf - Verschuldung in den deutschen Bundesländern: 

 
Eine 3D-Gitternetzdarstellung wird über den Menübefehl 

Analysen > 3D Gitternetz 

bzw. mit dem Steuerelement1  angefordert und in folgender Dialogbox spezifiziert: 

                                                 
1 Per Mausklick auf das kleine Dreieck erscheint ein Menü mit den in Abschnitt 8 beschriebenen Darstellungsoptionen. Die 

zuletzt beim aktuellen Arbeitslayer benutzte Option ist anschließend im Steuerelement direkt anwählbar. 
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Die spezifischen Bedienelemente der Dialogbox 3D-Gitter befinden sich auf dem Registerblatt Gitter: 

 Man legt fest, … 

- wie viele Gitterspalten bzw. Gitterzeilen gebildet werden sollen, 
- ob (wie im Beispiel) ein Zellraster gezeichnet werden soll, 
- was mit leeren Zellen passieren soll, die kein geographisches Objekt enthalten bzw. tangie-

ren. 

 Welche Berechnungsverfahren für die Höhenwerte der Zellen zur Verfügung stehen, hängt teilweise 
vom Layertyp ab. Bei Gebiets- oder Flächenschichten können Sie zwischen den folgenden Verfahren 
wählen: 

- Petrovskii-Verfahren 
Der Wert eines Gebietes oder einer Fläche wird anteilig auf die darauf liegenden Zellen ver-
teilt. Diese Methode ist angemessen, wenn der Wert durch Kumulieren über die gesamte Flä-
che entstanden ist (z.B. Einwohnerzahl). Der Wert eines großen Gebiets wird auf viele Zellen 
aufgeteilt, die jeweils einen kleinen Anteil erhalten. 

- Hauptwert-Verfahren 
Der Wert eines Gebietes oder einer Fläche wird von allen darauf liegenden Zellen übernom-
men. Diese Methode ist angemessen, wenn der Wert ohne Relativierung am Flächeninhalt in-
terpretiert werden kann (z.B. Kaufkraftindex pro Einwohner). Alle Zellen über einem großen 
Gebiet erhalten denselben, unveränderten Wert. 

Für die Darstellung der Pro-Kopf - Verschuldung ist offenbar das Hauptwert-Verfahren angemessen. 

 Über die Höhe wählen Sie die Ausdehnung der Karte in der dritten Dimension. 

 Mit dem Glättungsfaktor legen Sie fest, wie stark die Werte der Nachbarzellen berücksichtigt wer-
den sollen. 

Auf dem Registerblatt Daten wird nach dem üblichen Schema eine Klasseneinteilung definiert. Klassiert 
werden nicht die ursprünglichen Merkmalsausprägungen der geographischen Objekte, sondern die resul-
tierenden Höhenwerte der Zellen. 

Im Beispiel wurden die Intervallgrenzen manuell festgelegt. Außerdem wurde bei den Legendentexten 
Hand angelegt. Obwohl die Variable SCHULREL in der Tabelle zur Gebietsschicht den Datentyp Ganz-
zahl besitzt, zeigen die Standardtexte der Legende zum 3D-Gitter bei den Intervallgrenzen vier Dezimal-
stellen, die im Beispiel gelöscht wurden. 

Das Erscheinungsbild einer 3D-Gitternetz - Darstellung hängt entscheidend von der Perspektive ab, die 
nach dem Menübefehl 
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Landkarte > Perspektive 

mit dem folgenden Werkzeug eingestellt werden kann: 

 

8.9.2 3D-Prismen - Darstellung 

Bei dieser univariaten, auf Gebiets- oder Flächenlayer beschränkten Darstellungsart werden Gebiete oder 
Flächen in Abhängigkeit von der dargestellten numerischen Variablenausprägung unterschiedlich hoch 
aus der Ebene herausgehoben. Die resultierenden „Tafelberge“ eignen sich vermutlich besser zur Darstel-
lung der Pro-Kopf - Schulden in den Bundesländern als die im letzten Abschnitt benutzte Gitternetztech-
nik: 

 
Die 3D-Prismen-Darstellung wird über den Menübefehl 
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Analysen > 3D Prismen 

bzw. mit dem Steuerelement1  angefordert und in folgender Dialogbox spezifiziert: 

 
Auf dem Registerblatt Daten finden sich zwei spezielle Steuerelemente: 

 Mit dem Kontrollkästchen Gleiche Höhe können Sie bestimmen, ob die Höhenzuwächse der einzel-
nen Plateaus identisch oder analog zu den Werten der Klassen ausfallen sollen. 

 Mit dem Schieber Höhe wird ein Multiplikator für die Höhenwerte zu den einzelnen Klassen ge-
wählt. 

Wie bei jeder 3D-Darstellung hängt das Erscheinungsbild wesentlich von der Perspektive ab, die nach 
dem Menübefehl 

Landkarte > Perspektive 

mit dem folgenden Werkzeug eingestellt werden kann: 

 
 

8.10 Darstellung durch Diagramme 

RegioGraph bietet die folgenden Diagramm-Grundtypen, von denen jeweils mehrere Varianten existie-
ren: 

                                                 
1 Per Mausklick auf das kleine Dreieck erscheint ein Menü mit den in Abschnitt 8 beschriebenen Darstellungsoptionen. Die 

zuletzt beim aktuellen Arbeitslayer benutzte Option ist anschließend im Steuerelement direkt anwählbar. 
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 Kreise  Flächen 

 Ringe  Auszählungen 

 Segmentflügel  Klaiberdiagramme 

 Sterne  Skalierte Symbole 

 Balken  Körper 

 Stapel  Linien 

 

8.10.1 Kreisdiagramme 

Um z.B. die Landesergebnisse der Bundestagswahl 2009 dazustellen, bietet es sich an, zu jedem Bundes-
land ein eigenes Kreisdiagramm zu zeichnen: 

 
Aus rein ästhetischen Gründen wurde der Gebietslayer Höhenschichten Deutschland als Unterlage 
verwendet. Die Legende wurde im Layoutmodus komplett manuell erstellt. 

Die Diagrammdarstellung wird über den Menübefehl 

Analysen > Diagramme 
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bzw. mit dem Steuerelement1  angefordert und in folgender Dialogbox spezifiziert: 

 
Bei der Spezifikation von Kreisdiagrammen legt man nach der Typ-Bestimmung auf dem Daten-
Registerblatt die Variablen zu den einzelnen Kreissegmenten fest und sorgt für passende Farben. 

Auf dem Registerblatt Darstellung wählt man den Durchmesser der Kreisdiagramme über das Textfeld 
Max. Diagrammgröße: 

 

Auf eine Beschriftung der Kreisdiagramme 

 
wurde im Beispiel verzichtet. Wenn genügend Platz vorhanden, ist, kann man sie auf dem Registerblatt 
Beschriftung anfordern. 
 

8.10.2 Balkendiagramme 

Um die Kreisdiagramme auf dem obigen Arbeitsblatt durch Balkendiagramme zu ersetzen, sind nur we-
nige Mausklicks erforderlich. Für die Ästhetik im Untergrund sorgt diesmal der Gebietslayer Schum-
merung Deutschland:2 

                                                 
1 Per Mausklick auf das kleine Dreieck erscheint ein Menü mit den in Abschnitt 8 beschriebenen Darstellungsoptionen. Die 

zuletzt beim aktuellen Arbeitslayer benutzte Option ist anschließend im Steuerelement direkt anwählbar. 
2  Zu Deutschland, Österreich und der Schweiz bietet der Hersteller GfK GeoMarketing auf der Webseite 

http://www.regiograph.de/anwenderunterstuetzung/downloads.html Schummerungs- bzw. Reliefkarten als kostenlose Op-
tion an. Auf den Pool-PCs an der Universität Trier sind die Reliefkarten in die Kartenbibliothek zu finden (Ordner Topo-
graphie). 
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In Bezug auf die Vergleichbarkeit der Balkenhöhen wählt man in der Dialogbox Diagramme auf dem 
Registerblatt Daten 

 
zwischen den folgenden Alternativen: 

 Werte sind in allen Diagrammen vergleichbar 
Die Balkenhöhen sind auch zwischen zwei Diagrammen vergleichbar. 

 Werte innerhalb eines Diagramms vergleichbar 
RegioGraph legt die Balkenwerte in jedem Diagramm separat nach lokalen Kriterien fest, so dass z.B. 
gleich hohe Balken in verschiedenen Diagrammen im Allgemeinen nicht denselben Wert ausdrücken. 
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 Werte in der gleichen Spalte sind vergleichbar 
Es sind nur Vergleiche zwischen den aus verschiedenen Diagrammen stammenden Balken zu selben 
Variablen möglich, so dass z.B. gleich hohe Balken innerhalb eines Diagramms im Allgemeinen nicht 
denselben Wert ausdrücken, weil sie zu verschiedenen Variablen gehören. 

 

8.10.3 Skalierte Symbole 

In der folgenden Abbildung werden skalierte Symbole verwendet, um die Stimmanteile der Grünen bei 
der Bundestagswahl 2009 darzustellen: 

 
Hier leistet RegioGraph die in Abschnitt 8.4 (Klassen einer numerischen Variablen durch Symbole dar-
stellen) vermisste automatische Orientierung der Symbolgrößen an den dargestellten Merkmalsausprä-
gungen. 

Auf dem Daten-Registerblatt der Dialogbox Diagramme sind ein Symbol und eine numerische Variable 
zu wählen: 
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Das Symbol 

 
wurde aus einer Datei im WMF-Format (Windows Meta File) importiert. 

Um die Stimmanteile der Grünen in den Bundesländern als Beschriftung anzeigen und dabei frei positio-
nieren zu können, wurde eine zusätzliche Bundesländerschicht mit transparenter Darstellung aufgenom-
men. 

 
Diese Schicht befindet sich ganz oben und zeigt bei isolierter Betrachtung 

 
nur die Beschriftungen (Stimmanteile der Grünen): 
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8.11 Entfernung zum nächsten oder zum zugeordneten Standort 

Für die Objekte einer Gebiets-, Flächen oder Punkteschicht kann die Entfernung zum nächstgelegenen 
Standort, wobei es sich um ein Objekt auf einer Punkteschicht handelt, farblich dargestellt werden. Im 
folgenden Beispiel ist für die Gemeinden in Rheinland-Pfalz die Entfernung zur nächsten Stadt mit mehr 
als 100.000 Einwohnern dargestellt: 

 
Sofern der Arbeitslayer Gebiete, Flächen oder Punkte enthält und außerdem noch eine Standortpunkte-
schicht verfügbar ist, kann die Entfernungsanalyse mit dem Menübefehl 

Analysen > Entfernung zum nächsten Standort 

bzw. mit dem Steuerelement1  angefordert und in folgender Dialogbox spezifiziert werden: 

 

                                                 
1 Per Mausklick auf das kleine Dreieck erscheint ein Menü mit den in Abschnitt 8 beschriebenen Darstellungsoptionen. Die 

zuletzt beim aktuellen Arbeitslayer benutzte Option ist anschließend im Steuerelement direkt anwählbar. 
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Auf dem Daten-Registerblatt wird die Standortpunkteschicht gewählt und die Entfernung auf gewohnte 
Weise in Klassen eingeteilt (vgl. Abschnitt 8.3). 

In obige Karte wurden noch die Autobahnen als wesentliche Verbindungswege aufgenommen, was die 
Eisenbahnfans mir nachsehen mögen. Die fette Außengrenze stammt von einer Bundesland-Gebiets-
schicht, so dass insgesamt folgende Schichten beteiligt sind: 

 

Die Einschränkung auf Rheinland-Pfalz realisiert man am besten über das Kopieren und Einfügen einer 
Region (vgl. Abschnitt 6.13). 

In der Umgebung von Ludwigshafen fallen einige Gebiete mit verblüffender Nähe zum Oberzentrum auf. 
Durch Markieren findet man heraus, dass offenbar einige Orte über nicht zusammenhängende Gebiete 
verfügen (z.B. Weisenheim am Sand, blau gefärbt). 

 

Soll sich die Entfernungsmessung nicht auf den nächstgelegenen, sondern auf einen speziell zugewiese-
nen Standort aus einer Punkteschicht beziehen, ist in der Tabelle mit den zu messenden Objekten eine 
Variable mit den zugeordneten Standorten erforderlich. Mit dem Menübefehl 

Analysen > Entfernung zum zugeordneten Standort 

bzw. mit dem Steuerelement1  fordert man die folgende Dialogbox an, die im Vergleich zur obigen 
Variante zusätzlich die Registerkarte Standorte bietet: 

 
Wegen der stattlichen Anzahl rheinland-pfälzischer Gemeinden wird darauf verzichtet, eine entsprechen-
de Variante von obiger Karte herzustellen. 
 

                                                 
1 Per Mausklick auf das kleine Dreieck erscheint ein Menü mit den in Abschnitt 8 beschriebenen Darstellungsoptionen. Die 

zuletzt beim aktuellen Arbeitslayer benutzte Option ist anschließend im Steuerelement direkt anwählbar. 
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8.12 ABC-Analyse 

Bei der ABC-Analyse für eine Gebiets-, Flächen- oder Punkteschicht kann man z.B. für eine Umsatzvari-
able darstellen, welche Objekte (bei absteigender Sortierung nach Umsatz) für p1 < p2 < … Prozent des 
Gesamtumsatzes gesorgt haben. In der folgenden Karte ist zu sehen, auf welche Bundesländer man sich 
beschränken kann, wenn man 50, 75, 90 oder 95 Prozent der Ärzte ansprechen möchte: 

 
Man fordert die Dialogbox zur Spezifikation einer ABC-Analyse mit dem Menübefehl 

Analysen > ABC-Analyse 

oder mit dem Steuerelement1  an: 

                                                 
1 Per Mausklick auf das kleine Dreieck erscheint ein Menü mit den in Abschnitt 8 beschriebenen Darstellungsoptionen. Die 

zuletzt beim aktuellen Arbeitslayer benutzte Option ist anschließend im Steuerelement direkt anwählbar. 
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Hier wählt bzw. ändert man: 

 die darzustellende numerische Variable 
 die Anzahl der Klassen 
 die Art der Klassengrenzen 
 die Werte der Klassengrenzen 
 die Farben der einzelnen Kategorien oder einen Farbverlauf 
 die Gestaltung der Legende 

Bei der regionalen ABC-Analyse (Menübefehl Analysen > Regionale ABC-Analyse, Steuerelement 
) verteilt man die Objekte auf separat behandelte Regionen, so dass etwa regionale Umsatzschwer-

punkte erkennbar werden. 
 

8.13 Radialanalyse 

Bei der für Gebiets-, Flächen- und Punkteschichten verfügbaren Radialanalyse kann man z.B. für eine 
Umsatzvariable und einen Standort die Umkreise darstellen, deren Objekte p1  < p2 < … Prozent des Ge-
samtumsatzes erbringen. 

Sind mehrere Standorte vorhanden, … 

 wird jedes Objekt dem nächstgelegenen Standort zugeordnet 
 werden die Umkreise für jeden Standort separat gebildet 
 bildet die Summe aller Beiträge der Objekte eines Standorts die Bezugsgröße für Prozentangaben 

In der folgenden Abbildung werden die Kaufkraftsummen der deutschen Gemeinden in den Einzugsbe-
reichen der Metropolen Trier und Berlin dargestellt. Dazu kommt neben der Gebietsschicht mit den deut-
schen Gemeinden, die von RegioGraph inklusive Kaufkraftdaten geliefert wird, eine geeignete Punkt-
schicht mit den beiden Standorten zum Einsatz. Diese wurde aus der Punkteschicht Deutschland Städ-
te >100.000 2009 durch Ausblenden der nicht benötigten Objekte erstellt. Für jede Metropole sind die 
kleinstmöglichen Umkreise mit den Gemeinden zu sehen, die bereits 20, 40, 60, 80 bzw. 100 Prozent der 
Standort-Kaufkraftsumme beisteuern: 
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Zum dunkelgrünen Bereich um Trier gehört eine Gemeinde genau dann, … 

 wenn ihre Entfernung von Trier geringer ist als ihre Entfernung von Berlin, 

 wenn sie zum kleinstmöglichen Umkreis um Trier gehört, der bereits 20% der zu diesem Standort 
gehörenden Kaufkraftsumme erbringt. 

ABC- und Radialanalyse unterscheiden sich in Bezug auf das Kriterium für die Anordnung der geogra-
phischen Objekte: 

 Bei der ABC-Analyse werden die Objekte nach der Zielvariablen (z.B. Umsatz) absteigend geordnet. 

 Bei der Radialanalyse werden die Objekte nach der Entfernung zu einem Standort aufsteigend geord-
net. Sind mehrere Standorte vorhanden, werden die Objekte dem jeweils nächstgelegenen zugeordnet. 

Man fordert die Dialogbox zur Spezifikation einer Radialanalyse mit dem Menübefehl 

Analysen > Radial-Analyse 

oder mit dem Steuerelement1  an: 

                                                 
1 Per Mausklick auf das kleine Dreieck erscheint ein Menü mit den in Abschnitt 8 beschriebenen Darstellungsoptionen. Die 

zuletzt beim aktuellen Arbeitslayer benutzte Option ist anschließend im Steuerelement direkt anwählbar. 
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Hier wählt bzw. ändert man: 

 die Punkteschicht mit den Standorten 
 die darzustellende numerische Datenspalte 
 die Anzahl der Klassen 
 die Art der Klassengrenzen 
 die Werte der Klassengrenzen 
 die Farben der einzelnen Kategorien oder einen Farbverlauf 
 die Gestaltung der Legende 

Wie bei der ABC-Analyse existiert auch zur Radialanalyse eine regionale Variante. 
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9 Grafik-Export 

9.1 Export via Zwischenablage 

Ein RegioGraph-Arbeitsblatt kann bequem via Windows-Zwischenablage komplett oder teilweise in eine 
andere Anwendung übernommen werden. Dabei ist zu beachten: 

 Ausgangspunkt ist ein im Layout-Modus geöffnetes Arbeitsblatt. 

 Sind Markierungen vorhanden, werden nur die markierten Layout-Objekte übertragen, anderenfalls 
werden alle Layout-Objekte übertragen. Achten Sie also bei der geplanten Übertragung eines kom-
pletten Arbeitsblatts darauf, dass keine Markierungen vorhanden sind. 

 Das Übertragen in die Zwischenablage wird wie üblich mit Bearbeiten > Kopieren oder Strg+C 
angefordert. 

 Im Zielprogramm taugt bei traditioneller Menübedienung zur Übernahme einer Karte der Menübefehl 
Bearbeiten > Einfügen. Bei Microsoft Word© 2010 ist aus dem Start-Menüband das Einfügen-
Symbol zu verwenden: 

 
Die bequeme Tastenkombination Strg+V sollte bei allen Programmen klappen. 

Man erhält eine Vektorgrafik, so dass eine Vergrößerung ohne Qualitätsverluste möglich ist. Bei Farbver-
läufen resultiert aber auf diesem Weg kein gutes Ergebnis, z.B.: 

 
In diesem Fall ist ein Transfer als Pixelgrafik günstiger: 

 
Um ein von RegioGraph angezeigtes Arbeitsblatt als Pixel- bzw. Bitmap-Grafik in die Windows-
Zwischenablage zu befördern, verwendet man die Tastenkombination Alt+Druck. 
 

9.2 Export in eine Datei 

Über den Menübefehl 
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Datei > Exportieren 

können Sie ein Arbeitsblatt (stets komplett) in eine Datei exportieren: 

 Wählen Sie im ersten Assistentendialog das Speichern als Grafik: 

 

 Im nächsten Dialog 

 
wählt man: 

o das zu exportierende Arbeitsblatt 

o das Format der zu erstellenden Graphikdatei (erlaubt: PNG, GIF, TIF, BMP und JPEG, EMF 
und PDF) 

o den Dateinamen 

o die Größe und Auflösung der Graphik 
Verwendet man das Dateiformat EMF, werden Vektorinformationen gespeichert, und die im Ex-
port-Assistentendialog angegebene Auflösung ist nur relevant für enthaltene Muster und Textu-
ren. 

o die Farbkonfiguration (abhängig vom Exportformat) 
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9.3 HTML-Export 

Über den Menübefehl 

Datei > Exportieren 

kann man ein Arbeitsblatt zusammen mit ausgewählten Daten als interaktives HTML-Dokument expor-
tieren: 

 Wählen Sie im ersten Assistentendialog das Speichern als HTML-Dokument: 

 

 Im nächsten Dialog 

 
wählt man: 

o das zu exportierende Arbeitsblatt 
o die Bildbreite- und -höhe 

Im Beispiel wurde für den Bildschirmauftritt ein quadratisches Arbeitsblatt erstellt. 
o die Ausrichtung der Karte im Browser-Fenster 
o den Namen der HTML-Datei 

 Für die Quickinfo-Ausgabe im Internet-Browser kann man Merkmale aus einer Schichttabelle wäh-
len und jeweils einen Präfix sowie einen Suffix festlegen. Im Beispiel sollen die Ergebnisse der Bun-
destagswahl 2009 angezeigt werden: 
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Für die Hyperlink-Spalten bestehen folgende Optionen: 

o Anzeige einer von RegioGraph automatisch erstellte HTML-Seite mit Tabellendaten 
o Aufruf einer URL, die sich in einer Spalte der Layertabelle befinden muss 

Im Beispiel werden automatisch erstellte Tabellen gewählt, so dass insgesamt 18 Dateien (mit einer be-
scheidenen Gesamtgröße von 172 KB) resultieren: 

 eine Datei mit der HTML-Startseite 

 eine GIF-Datei mit der Karte 
Weil das GIF-Format auf 256 verschiedene Farben beschränkt ist, sollten Sie bei geplantem HTML-
Export auf Farbverläufe verzichten. Wie das folgende Beispiel zeigt, mutiert ein Farbverlauf zu einem 
Streifenmuster: 

 
 für jedes Bundesland eine HTML-Datei mit einer Tabelle 

Das Ergebnis: 
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Per Mausklick auf ein Bundesland erhält man eine Tabelle mit Detailangaben, z.B. für Niedersachsen: 

 
Um die Tabelle attraktiver zu machen, sollte man in der Gebietsschichttabelle die Spaltennamen ändern. 
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10 Gebietsschichten per Karteneditor erstellen oder modifizieren 
RegioGraph Planung enthält einen Landkarteneditor, mit dem man eigene Gebietesschichten erstellen 
oder vorhandene (z.B. mit RegioGraph gelieferte) Gebietsschichten ändern kann. Wir beschränken uns im 
Folgenden auf einfache Anwendungen. 

10.1 Bitmap-Karten digitalisieren 

10.1.1 Bitmap laden 

Anschließend wird beschrieben, wie man aus einer Karte im Bitmap-Format (z.B. per Scanner erzeugt) 
eine RegioGraph-Gebietsschicht erstellt. Als Beispiel dient die folgende Karte des Großherzogtums Lu-
xembourg:1 

 Luxembourg Topographie
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Strassen
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Esch-sur-Alzette

Luxembourg
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 Luxembourg Topographie

 

Wir legen ein neues Projekt an, übernehmen aus der Kartenbibliothek die Gebietsschicht Welt Staaten 
in die Projektverwaltung und starten den Editor über den Menübefehl: 

Karteneditor > Editor starten 

Bei aktivem Editor befindet sich in der Registerleiste unter dem (vom Editor stets komplett belegten) Do-
kumentenbereich die Registerkarte Karteneditor. 

                                                 
1 Diese Karte wurde einem mit RegioGraph 8 gelieferten Premium-Projekt entnommen und für die folgenden Erläuterungen 

auf Bitmap-Format reduziert. 
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Wir ziehen die Gebietsschicht Welt Staaten aus dem Layer-Ordner der Projektverwaltung auf den Kar-
teneditor und wählen einen zur Bitmap-Datei passenden Kartenausschnitt (siehe Abschnitt 6.3). Nach 
dem Menübefehl 

Karteneditor > Bild positionieren 

können wir die Bitmap-Datei öffnen, wobei der neue Objektlayer Positionierte Bilder mit der Bitmap-
Graphik entsteht. Außerdem erscheint das Fenster Bild positionieren. 

Die Situation im folgenden Bildschirmphoto 

 
ist folgendermaßen zu erreichen: 

 Die Gebietsschicht Welt Staaten wird per Karteninhaltsfenster in die Top-Lage gebracht und er-
hält den Arbeitslayer-Status, wobei die Dialogbox Bild positionieren verschwindet. 

 Die Grenzlinien auf der Gebietsschicht werden über den Menübefehl Format > Linie deutlich 
sichtbar gemacht (schwarz, 1 mm breit). 

 Anschließend wird der Objektlayer Positionierte Bilder wieder zum Arbeitslayer gemacht 

 
und mit dem Menübefehl Karteneditor > Bild positionieren Dialogbox Bild positionieren 
zurück geholt. 

 

10.1.2 Bitmap referenzieren 

In der Dialogbox Bild positionieren erstellt man so genannte Passpunkte (mindestens drei) mit be-
kannten geographischen Koordinaten. Man setzt einen neuen Passpunkt mit dem -Werkzeug, indem 
man ... 

 zunächst einen Punkt auf der Bitmap-Karte 
 und dann einen Punkt auf der Gebietsschicht angeklickt. 

In der Regel wird man so keine hinreichende Präzision erreichen und hinterher in der Dialogbox Bild 
positionieren die geographischen Koordinaten korrigieren, z.B.: 
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Mit dem Symbolschalter  aktiviert man die Anzeige der Passpunkte in der Bitmap-Grafik. 

Hinweise zur Verwendung der Tabelle im Fenster Bild positionieren: 

 Das Editieren einer Zelle wird durch einen Doppelklick eingeleitet. 
 Die geographischen Koordinaten sind in dezimalen Graden einzugeben, wobei ein Komma als 

Dezimaltrennzeichen zu verwenden ist. 
 Ein in der Tabelle markierter Passpunkt lässt mit dem Symbolschalter  löschen. 

Für die Beispielkarte können die folgenden vier Passpunkte verwendet werden: 

Geographische Koordinaten 
Passpunkt Ort 

Länge Breite 
P1 Echternach 6,433827 49,809769 
P2 Luxemb. Stadt 6,130940 49,611940 
P3 Hosingen 6,090283 50,020804 
P4 Differdange 5,890104 49,523483 
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10.1.3 Gebietsschicht erzeugen 

Nachdem nun die geographischen Koordinaten aller Bitmap-Punkte festliegen, erzeugt man einen neuen 
Gebietslayer über die Option: 

Neuer Layer > Gebiete 

aus dem Kontextmenü zu einem vorhandenen Eintrag im Karteninhaltsfenster. Wir legen der Übung hal-
ber eine Gebietsschicht mit den Kantonen Luxemburgs an, obwohl in der Kartenbibliothek eine solche 
Schicht bereits existiert. 

Ist der neue Gebietslayer aktiv, kann man mit dem Menübefehl 

Einfügen > Polygon 

das Werkzeug  zur Definition von neuen Polygonen (Gebieten) aktivieren und dann durch Maus-
klicks ein Polygon mit beliebig vielen Zwischenpunkten festlegen, z.B. 

 
Statt einzelne Punkte anzuklicken, kann man auch mit festgehaltener Maustaste einen Grenzverlauf frei-
händig zeichnen. Nach dem Schließen des Polygons per Doppelklick wird die Kennung der neuen Fläche 
abgefragt, z.B.: 

 
Vor der Definition weiterer Gebiete sollte man im Karteninhaltsfenster den linken Punkt zum Gebietslay-
er per Mausklick blau färben, um die Einrastfunktion entlang gemeinsamer Grenzverläufe zu aktivieren: 

 
Stößt man bei der Definition weiterer Gebiete auf vorhandene Grenzen, so werden diese vom Editor au-
tomatisch verfolgt, so dass ohne erneute Grenzdefinition passgenaue Gebiete entstehen, z.B.: 
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Um die Stützstellen im Grenzverlauf eines markierten Gebiets ändern zu können, muss man sie sicht- und 
manipulierbar machen: 

 Im Karteninhaltsfenster macht man die neue Gebietsschicht zum Arbeitslayer und aktiviert per-
Mausklick auf den rechten Punkt die Anzeige der Stützstellen: 

 

 Jetzt wählt man das Standardwerkzeug  und markiert das betroffene Gebiet. Soll die gemeinsa-
me Grenze von zwei benachbarten Gebieten korrigiert werden, müssen beide Gebiete markiert 
sein. Zum kumulierenden Markieren ist die Umschalttaste zu drücken. 

 Nun kann man die Stützstellen wie bei einem Polygon verändern (siehe Abschnitt 6.14.2). 

Hier wurde der Grenzverlauf zum Gebiet Echternach verfeinert: 
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10.1.4 Speichern 

Wenn Sie über das Kontextmenü zur Registerkarte des Karteneditors (unter dem Dokumentenbereich) das 
Speichern anfordern, fragt RegioGraph, in welchem Arbeitsblatt die Editorkarte gespeichert werden 
soll, z.B. 

 
Auf die Detailnachfrage hin sollte man die Änderungen an der Objekt- und der Gebietsschicht speichern: 

 
Das beim Anlegen des Projekts automatisch angelegte Arbeitsblatt kann gelöscht werden, sodass die Pro-
jektverwaltung folgendes Bild zeigt: 

 

Die neue Gebietsschicht kann umbenannt und per Kontextmenü in der Kartenbibliothek gespeichert wer-
den. 
 

10.2 Gebietsschichten modifizieren 

Um eine vorhandene Gebietsschicht zu ändern, geht man so vor: 

 RegioGraph starten und das Projekt öffnen 
 ein Arbeitsblatt mit der Gebietsschicht öffnen 
 den Editor starten über den Menübefehl Karteneditor > Editor starten 

Wenn Sie über die Registerkarte des Karteneditors unter dem Dokumentenbereich das Speichern anfor-
dern, erkundigt sich RegioGraph, ob im aktuellen oder in einem neuen Arbeitsblatt gespeichert werden 
soll, z.B.: 
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10.2.1 Gebiet erstellen 

Nach dem Menübefehl 

Einfügen > Polygon 

kann über das Werkzeug  durch Mausklicks das Polygon eines Gebiets definiert werden (siehe Ab-
schnitt 10.1.3). 
 

10.2.2 Gebiet löschen 

Ein markiertes Gebiet kann über den Menübefehl 

Bearbeiten > Löschen 

oder die Entf-Taste gelöscht werden. 
 

10.2.3 Gebiete auftrennen 

Um ein Gebiet aufzuteilen, markiert man es und wählt dann den Menübefehl 

Karteneditor > Ausgewähltes Objekt teilen 

Anschließend legt man die Grenzlinie fest: 

 Start mit einem Stützpunkt auf der Grenze des alten Gebiets. 
 Durch Mausklicks die Stützstellen der neuen Grenzlinie festlegen 
 Abschluss per Mausklick auf einen Stützpunkt im Grenzverlauf des alten Gebiets. 

Schließlich sind in der Layertabelle die Kennungen der beiden neuen Gebiete zu aktualisieren. 
 

10.2.4 Gebiete verschmelzen 

Um zwei oder mehrere Gebiete zu verschmelzen, markiert man sie und wählt dann den Menübefehl 

Karteneditor > Ausgewählte Objekte verschmelzen 

In einem Dialog muss geregelt werden, wie die Variablenausprägungen in der Layertabelle für das neue 
Objekte aus den entsprechenden Werten seiner Vorfahren berechnet werden sollen. 
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11 Weitere Möglichkeiten in RegioGraph Planung 
Von den vielen RegioGraph-Optionen, die in diesem Manuskript nicht behandelt wurden, sind folgende 
besonders herauszuheben: 

 Gebietsplanung 

 Berechnungen von Flächen, Entfernungen etc. 
RegioGraph kann u.a. Flächen, Umfänge, Längen und Entfernungen (zum nächstgelegenen oder zuge-
ordneten Standort) berechnen und in einer Layertabelle ablegen (siehe Menü Berechnungen). 

 Gebietshierarchien 
Die auf Gebietsschichten enthaltenen Basisgebiete können zu größeren Gebietseinheiten zusammenge-
fasst werden. Die mit den Basisgebieten verknüpften Daten werden dabei automatisch ebenfalls aggre-
giert. Durch wiederholte Aggregation kann eine Gebietshierarchie erstellt werden. Änderungen der 
Gebietsstruktur und/oder der Daten werden dynamisch auf allen Gebietsebenen übernommen. 

 Positionen über Adressen suchen 
 
 



 

 127 

Thematische Kartographie mit RegioGraph 11 
 

12 Stichwortregister 

3 
3D-Gitternetz  99 
3D-Prisma  101 

A 
ABC-Analyse  110 
Abgleichspalten  33 
Access  31 
Adressen  64, 66 
Aggregation  126 
Aggregieren  31 
Arbeitsblatt  14 
Arbeitsblätter  9 
Arbeitsblattfenster  17 
Arbeitsblattvorlage  16 
Arbeitslayer  46 
Auffüllen  44 
Ausrichten  28 
Auswahlfenster  56 

B 
Basisgebiete  126 
Berechnungen  126 
Beschriftung 

freistellen  92 
Beschriftungen  52 

D 
Daten importieren  31 
Datentyp  31 
dBase  31 
Dezimalstellen  41 
Diagramme  102 
Digitalisieren  119 
Drehen  61 

E 
Editor  119 
Eigenschaftsdialog  27 
Einpassen einer Karte  51 
Ellipse  20 
EMF  115 
Entfernung 

zum nächsten Standort  108 
zum zugeordneten Standort  109 

Entfernungsmessung  58 
ESRI Shape  6 
Excel  31 
Exportieren 

in Datei  114 
über Zwischenablage  114 

F 
Farbe 

transparente  21 
Flächen  8 
Flächenlayer  67 

Formate übertragen  28 
Formelsyntax  42 
Fragmentierung der Projektdatei  16 
Freistellen  92 
Füllung 

von Flächen  23 

G 
Gebiete  8 

Basisgebiete  126 
Gebietsplanung  126 
Geographische Objekte 

aus- und einblenden  51 
Geokodieren  64, 66 
GfK  7 
GIS-Software  6 
Gitternetz  60 
Grafik 

aus Datei  20 
aus Palette  20 

Grafikobjekte  19 
Größe anpassen  29 
Gruppieren  30 

H 
Haupteffekte  96, 98 
Hauptwert-Verfahren  100 
Hintergrundkarten  8, 11 
Horizontal verteilen  29 
Horizontal zentrieren 

Bzgl. Arbeitsblatt  29 
Bzgl. Objekt  29 

HTML-Export  116 

I 
imp-Datei  35 
Importieren 

von Daten  31 
Infolayer  47, 56 
Infos zu geographischen Objekten  56 
Initialisierungswert  44 

K 
Karten, mitgelieferte  6 
Kartenbibliothek  12 
Kartenbibliotheks-Verzeichnis  12 
Karteninhalt  45 
Karteninhalt  15 
Kaufkraftdaten  7 
Kennung  8 
Kippen  61 
Klassengrenzen  83 
Kreis  20 

L 
Landkarten-Modus  16 
Layer  11 

erstellen  63 
Layout-Modus  16, 19 
Legende  77, 84 
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Linie  19 
Linien  65 
Linienenden  25 
Linientyp  24 
Linksbündig  29 

M 
MapInfo Interchange Format  6 
Markieren 

geographische Objekte  48 
Grafikobjekte  23 
Zeilen einer Tabelle  49 

Maßstab  59 
Mehrdimensionale Symbole  87 
Muster editieren  95 

N 
Nordpfeil  59 

O 
Oben ausrichten  29 
Objekte, geographische  8 
Objektelayer  68 
Objektlegende  69 
ODBC  32 
Ole-Objekt einfügen  22 

P 
Palette  20, 95 
Passpunkte  120 
Perspektive  61, 100, 102 
Petrovskii-Verfahren  100 
Piktogrammerstellung  79 
PNG  80 
Polygon  20 
Portable Network Graphics  80 
Portfolio-Darstellung  92 
Prismen-Darstellung  101 
Projekt 

Erstellen  10 
Reorganisieren  15 
Speichern  15 

Projektdatei  11 
Projekte  9 
Projektion  61 
Projektverwaltung  11 
Punktdichtedarstellung  90 
Punkte  8 
Punktelayer  63 

Q 
Quadrat  20 
Quickinfo  46 

R 
Radialanalyse  111 
Rechteck  20 
Rechteck, gerundet  20 
Rechtsbündig  29 
RegioGraph Planung  6, 64, 66 
Region kopieren und einfügen  62 

Registerleiste  18, 119 
Reorganisieren  15, 16 
Rückgängig machen 

im Landkarten-Modus  45 
im Layout-Modus  19 

S 
Schatten  26 
Schicht 

aktive  45 
Schichten  8 
Schichtvorlagen 

erstellen  71 
übernehmen  12 

Schriftart  25 
Schummerung  104 
Sichern  45 
Skalierte Symbole  106 
Spalte 

löschen  44 
Spalten 

Sortieren  44 
Spalten 

aus- und einblenden  43 
sperren  40 
verschieben  43 

Spalteneigenschaften  40 
Standardeinstellungen  71 
Stapelordnung verändern  28 
Statistisches Bundesamt  36 
Strecken  8 
Symbol 

hinzufügen  86 
Symbol-Darstellung  84 
Symbol-Portfolio  96 

T 
Tabelle  8 
Tabellen 

Spalten sperren  40 
Tabellenbearbeitung  31 
Tabellenfenster  17, 31 
Tabulator-getrennte Textdateien  36 
Tausendertrennzeichen  40, 41 
Textfeld  20 
Titel 

einer Tabellenspalte  40 
Transparente Farbe  21 
Transparente Schichten  74 
Transparenz  23 

U 
Übertragen 

von Formaten  28 
Unten ausrichten  29 

V 
Verteilen  29 

horizontal  29 
vertikal  29 

Verteilung  83 
Vertikal verteilen  29 
Vertikal zentrieren 

Bzgl. Arbeitsblatt  29 
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Bzgl. Objekt  29 
Verzeigung  42 

W 
Wechselwirkung  96, 98 
Windows Meta File  86, 107 
WMF  107 
WMF-Format  86 

Z 
Zentrieren  25 
Zoom-Funktion  47 
Zwischenablage  114 
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		13		Mecklenburg-Vorpommern		23180		1707		846		861		74		39		834		302		532		6260		10232		9440		3864		12638		17285		1081158		915884		72084		57474		6903		186		7457		1		31,7		29,6		6,3		4		23,7		4,7		16,6		33,1		9,8		5,5		29		6		SPD/CDU		SPD/CDU		SPD/CDU		SPD/CDU		53,1596676896439		33669,5957820738		108,96309314587		3,6672524897481		10125,9519625073		-,272231985940246

		14		Sachsen		18416		4274		2083		2191		232		120		2186		870		1316		14329		27601		16767		8435		32556		48227		2718343		2332618		180347		122666		15601		275		4079		1		24,3		30,4		9,8		4,6		23		7,9		14,6		35,6		13,3		6,7		24,5		5,3		CDU/SPD		CDU/FDP		CDU/FDP		CDU/FDP		45,1252840425215		28700,5147402901		64,3425362657932		3,35259709873655		11283,8090781469		-,366658867571362

		15		Sachsen-Anhalt		20446		2470		1206		1264		121		47		1188		419		769		8087		17129		10114		5239		16927		29152		1558932		1335682		95611		82324		10111		219		9066		1		32,7		24,7		8,1		4,1		26,6		3,79999999999999		16,9		30,1		10,3		5,1		32,4		5,2		CDU/SPD		CDU/SPD		CDU/SPD		CDU/SPD		52,8079480054294		33329,5546558704		88,663967611336		3,27408906882591		11802,4291497976		-,494939271255061

		16		Thüringen		16172		2335		1150		1185		144		48		1123		410		713		7806		16638		9312		4844		16402		25604		1545720		1305114		99060		59178		8539		217		7626		1		29,8		25,7		7,9		4,8		26,1		5,7		17,6		31,2		9,8		6		28,8		6,6		CDU oder CSU		CDU/FDP		CDU/FDP		CDU/FDP		38,2850710348575		25343,8972162741		92,9336188436831		3,34304068522484		10965,3104925054		-,394089935760171



